The Meeting Transcript of
The Los Angeles County

Board of Supervisors




April 10, 2007

The Meeting Transcript of
The Los Angeles County Board of Supervisors

Adobe Acrobat Reader

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF
document. Acrobat Reader looks for the word by reading every word on every page in the file,
including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:
Match Whole Word Only finds only occurrences of the complete word you enter in
the box. For example, if you search for the word stick, the words tick and sticky will
not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in
the box.

Find Backwards starts the search from the current page and goes backwards through
the document.
4. Click Find. Acrobat Reader finds the next occurrence of the word.

To find the next occurrence of the word, Do one of the following:

Choose Edit > Find Again
Reopen the find dialog box, and click Find Again.
(The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it
into another application such as a word processor. You can also paste text into a PDF
document note or into a bookmark. Once the selected text or graphic is on the Clipboard, you
can switch to another application and paste it into another document.

Note: If a font copied from a PDF document is not available on the system displaying the
copied text, the font cannot be preserved. A default font is substituted.

The Meeting Transcript of
The Los Angeles County Board of Supervisors
1




April 10, 2007

The Meeting Transcript of
The Los Angeles County Board of Supervisors

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

To select a line of text, select the first letter of the sentence or phrase and drag to
the last letter.

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option
(Mac OS) as you drag across the width of the document.

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command
(Mac OS) as you drag the length of the document.

To select all the text on the page, choose Edit > Select All. In single page mode, all the text
on the current page is selected. In Continuous or Continuous — facing mode, most of the text
in the document is selected. When you release the mouse button, the selected text is
highlighted. To deselect the text and start over, click anywhere outside the selected text.
The Select All command will not select all the text in the document. A workaround for this
(Windows) is to use the Edit > Copy command. Choose Edit > Copy to copy the selected
text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the
Show Clipboard command until it is installed. To install the Clipboard Viewer, Choose
Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows
Setup tab. Double-click Accessories, check Clipboard Viewer, and click OK.

The Meeting Transcript of
The Los Angeles County Board of Supervisors
2




The Los Angeles County Board of Supervisors

April 10, 2007

The Meeting Transcript of

10

11

12

13

14

15

16

17

18

19

20

21

[REPORT OF ACTION TAKEN IN CLOSED SESSION

ON APRIL 10, 2007, BEGINS ON PAGE 93.]

SUP. YAROSLAVSKY, CHAIRMAN: SUPERVISORS, WE NOW HAVE A QUORUM.
WE'LL COME TO ORDER AND ASK EVERYONE TO STAND FOR THE
INVOCATION AND THE PLEDGE OF ALLEGIANCE. THE INVOCATION WILL
BE LED BY MINISTER NILAH HAGAN, DIVINE APPOINTMENT MINISTRY
FROM COMPTON AND THE PLEDGE OF ALLEGIANCE WILL BE LED BY
HILARIO GONZALES, MEMBER OF THE FRANK C. MARPE, CHAPTER NUMBER
44 OF THE DISABLED AMERICAN VETERANS OF THE UNITED STATES.

MINISTER HAGAN?

MINISTER NILAH HAGAN: THANK YOU AND GOOD MORNING AND I WANT TO
SAY TO MY ESTEEMED BOARD OF SUPERVISORS, YOU GUYS DO A
WONDERFUL JOB AND TODAY I JUST WANT TO ASK GOD TO ASK TO
CONTINUE TO BLESS AND GUIDE AND PROTECT OUR BOARD OF
SUPERVISORS FOR THE WONDERFUL WORK THAT THEY ARE DOING FOR
L.A. COUNTY AND THEIR CONSTITUENCY AND LET US ALL JUST SAY TO
THAT SPIRIT WITHIN US THAT WE'RE ALL CREATED EQUAL WITH AND
THAT CONNECTS WITH OUR SPIRITUAL UMBILICAL CORD TO THE GREAT
CREATOR OF THE WORLD, GOD BLESS US ALL. GOD CONTINUE TO BLESS
THE BOARD OF SUPERVISORS FOR THEIR WONDERFUL WORKS AND I JUST

WANTED TO SAY THAT, WHICH CAME FIRST, THE CHICKEN OR THE EGG?
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1 NEITHER. GOD CAME FIRST AND EVERYTHING ELSE CAME AFTER.

2 YOU.

4 HILARIO GONZALES: LET'S FACE THE FLAG, RAISE OUR HAND TO OUR

5 HEART. [ PLEDGE OF ALLEGIANCE ]

7 SUP. YAROSLAVSKY, CHAIRMAN: SUPERVISOR BURKE.

9 SUP. BURKE: MINISTER NILAH HAGAN OF DIVINE APPOINTMENT

10 MINISTRY IN COMPTON AND WE'RE VERY PLEASED TO HAVE YOU WITH
11 US. SHE RECEIVED HER CREDENTIALS IN MINISTRY FROM UNIVERSAL
12 LIFE CHURCH IN MODESTO, CALIFORNIA, IN 2000. AS A LAY

13 PREACHER, SHE STUDIED AND RESEARCHED VARIOUS RELIGIONS AND

14 SPIRITUAL DOCTRINES FROM 1975 TO THE PRESENT, HAS A B.A. IN
15 SPEECH COMMUNICATION THEORY FROM CALIFORNIA STATE UNIVERSITY
16 LONG BEACH. SHE'S WORKED FOR THE COUNTY, DEPARTMENT OF PUBLIC
17 SOCIAL SERVICES, FOR THE PAST 15 YEARS AND SHE'S STILL THERE,
18 WORKING WITH US AND WE REALLY APPRECIATE HAVING YOU HERE WITH
19 US TODAY. [ APPLAUSE ]

20

21 SUP. YAROSLAVSKY, CHAIRMAN: SUPERVISOR MOLINA.

22

23 SUP. MOLINA: THANK YOU. IT'S MY PLEASURE THIS MORNING TO MAKE

24 A PRESENTATION OF A CERTIFICATE OF APPRECIATION TO HILARIO

25 GONZALES. MR. GONZALES IS A MEMBER OF CHAPTER 44 OF THE
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1 DISABLED AMERICAN VETERANS. HE SERVED AS A SEAMAN IN THE
2 UNITED STATES NAVY FROM 1972 TO 1973 IN VIETNAM. HIS

3 DECORATIONS INCLUDE THE MEDAL OF GOOD CONDUCT, A NATIONAL

4 DEFENSE SERVICE MEDAL, THE VIETNAM SERVICE MEDAL WITH TWO

5 STARS AND THE REPUBLIC OF VIETNAM CAMPAIGN MEDAL AS WELL. MR.

6 GONZALES ATTENDED RIO HIGH SCHOOL IN EL MONTE AND RIO HONDO

7 COMMUNITY COLLEGE. HE PRESENTLY LIVES IN EL MONTE AND WE THANK
8 YOU SO MUCH FOR LEADING US IN OUR PLEDGE OF ALLEGIANCE. [

9 APPLAUSE ]

10

11 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. LET'S CALL THE AGENDA.

12

13 CLERK SACHI HAMAI: GOOD MORNING, MR. CHAIRMAN, MEMBERS OF THE

14 BOARD. WE WILL BEGIN TODAY'S AGENDA ON PAGE 6, AGENDA FOR THE

15 MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION, ITEMS 1-D AND
16 2-D. ON ITEM 1-D, AS INDICATED ON THE SUPPLEMENTAL AGENDA, THE
17 EXECUTIVE DIRECTOR OF THE COMMUNITY DEVELOPMENT COMMISSION

18 REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO APRIL 17TH,

19 2007.

20

21 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. I'D LIKE TO HOLD IT AND ASK

22 A FEW QUESTIONS AND THEN WE'LL CONTINUE IT. I HAVE NO

OBJECTION TO CONTINUING IT BUT I DO HAVE A FEW QUESTIONS.

CLERK SACHI HAMAI: AGENDA FOR THE MEETING OF THE HOUSING...
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2 SUP. YAROSLAVSKY, CHAIRMAN: SO DO WE HAVE 2-D BEFORE US?

4 CLERK SACHI HAMAI: I'M SORRY, CORRECT.

6 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. MOLINA MOVES, I'LL SECOND.

7 UNANIMOUS VOTE.

9 CLERK SACHI HAMAI: AGENDA FOR THE MEETING OF THE HOUSING

10 AUTHORITY, ITEMS 1-H THROUGH 3-H. ON ITEM 1-H, SUPERVISOR

11 YAROSLAVSKY AND SUPERVISOR ANTONOVICH REQUEST THAT THIS ITEM
12 BE HELD.

13

14 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. THEY'LL BE HELD. I MADE A
15 MISTAKE. I WAS NOT GOING TO HOLD 1-D. I'M SORRY. IT WAS 1-H.
16 SO MOLINA WILL MOVE, I'LL SECOND, UNANIMOUS VOTE ON 1-D AS
17  WELL.

18

19 CLERK SACHI HAMAI: 1-D WAS BEING CONTINUED ONE WEEK.

20

21 SUP. YAROSLAVSKY, CHAIRMAN: I'M SORRY. YOU'RE RIGHT. THAT'S
THE MOTION, TO CONTINUE IT FOR ONE WEEK. I'LL GET MY ACT

TOGETHER HERE.
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1 CLERK SACHI HAMAI: AND 1-H IS BEING HELD. AND 2-H AND 3-D ARE

2 BEFORE YOU.

4 SUP. YAROSLAVSKY, CHAIRMAN: BURKE MOVES, ANTONOVICH SECONDS.

5 UNANIMOUS VOTE.

7 CLERK SACHI HAMAI: AGENDA FOR THE MEETING OF THE REGIONAL PARK

8 AND OPEN SPACE DISTRICT, ITEM 1-P.

10 SUP. YAROSLAVSKY, CHAIRMAN: MOLINA MOVES, BURKE SECONDS.

11 UNANIMOUS VOTE.

12

13 CLERK SACHI HAMAI: BOARD OF SUPERVISORS, ITEMS 1 THROUGH 13.
14 ON ITEM 2, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO
15 HOLD THIS ITEM AND, ON ITEM 3, THERE'S ALSO A REQUEST FROM A
16 MEMBER TO HOLD THIS ITEM.

17

18 SUP. YAROSLAVSKY, CHAIRMAN: THOSE WILL BE HELD.

19

20 CLERK SACHI HAMAI: ON ITEM NUMBER 7, AS INDICATED ON THE

21 SUPPLEMENTAL AGENDA, THE RECOMMENDATION WAS REVISED TO ADD THE

22 WORDS "AND GROCER". AND ALSO SUPERVISOR ANTONOVICH AND A

23 MEMBER OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD.
24

25 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. IT WILL BE HELD.
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CLERK SACHI HAMAI: ON ITEM NUMBER 9, THERE'S A REQUEST FROM A

MEMBER OF THE PUBLIC TO HOLD THIS ITEM.

SUP. YAROSLAVSKY, CHAIRMAN: ON THE REMAINDER, BURKE MOVES,

ANTONOVICH SECONDS. UNANIMOUS VOTE.

CLERK SACHI HAMAI: AUDITOR CONTROLLER, ITEM 14.

SUP. YAROSLAVSKY, CHAIRMAN: ANTONOVICH MOVES, MOLINA SECONDS.

UNANIMOUS VOTE.

CLERK SACHI HAMAI: CHILDREN AND FAMILY SERVICES, ITEM 15.

SUP. YAROSLAVSKY, CHAIRMAN: BURKE MOVES, MOLINA SECONDS.

UNANIMOUS VOTE.

CLERK SACHI HAMAI: COMMUNITY DEVELOPMENT COMMISSION, ITEMS 16
AND 17. ON ITEM 16, AS INDICATED ON THE SUPPLEMENTAL AGENDA,
THE EXECUTIVE DIRECTOR OF THE COMMUNITY DEVELOPMENT COMMISSION
REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO APRIL 17TH,

2007.

SUP. YAROSLAVSKY, CHAIRMAN: WITHOUT OBJECTION, THAT WILL BE

THE ORDER.
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2 CLERK SACHI HAMAI: ITEM 17 IS BEFORE YOU.

4 SUP. YAROSLAVSKY, CHAIRMAN: MOLINA MOVES, ANTONOVICH SECONDS.

5 UNANIMOUS VOTE.

7 CLERK SACHI HAMAI: DISTRICT ATTORNEY, ITEMS 18 THROUGH 21.

9 SUP. YAROSLAVSKY, CHAIRMAN: ANTONOVICH MOVES, BURKE SECONDS.
10 UNANIMOUS VOTE.

11

12 CLERK SACHI HAMAI: HEALTH SERVICES, ITEMS 22 THROUGH 25.

13

14 SUP. YAROSLAVSKY, CHAIRMAN: BURKE MOVES, MOLINA SECONDS.

15 UNANIMOUS VOTE.

16

17 CLERK SACHI HAMAI: HUMAN RESOURCES, ITEM 26.

18

19 SUP. YAROSLAVSKY, CHAIRMAN: ANTONOVICH MOVES, MOLINA SECONDS.
20 UNANIMOUS VOTE.

21

22 CLERK SACHI HAMATI: INTERNAL SERVICES, ITEM 27.

SUP. YAROSLAVSKY, CHAIRMAN: ANTONOVICH MOVES, BURKE SECONDS.

UNANIMOUS VOTE.
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CLERK SACHI HAMAI: PUBLIC HEALTH, ITEM 28.

SUP. YAROSLAVSKY, CHAIRMAN: BURKE MOVES, MOLINA SECONDS.

UNANIMOUS VOTE.

CLERK SACHI HAMAI: PUBLIC WORKS, ITEMS 29 THROUGH 53. ON ITEM

NUMBER 30, SUPERVISOR YAROSLAVSKY REQUESTS THAT THIS ITEM BE

HELD.

SUP. YAROSLAVSKY, CHAIRMAN: OKAY. GO AHEAD.

CLERK SACHI HAMAI: AND THE REMAINDER IS BEFORE YOU.

SUP. YAROSLAVSKY, CHAIRMAN: ON THE REMAINDER, MOLINA MOVES,

BURKE SECONDS. UNANIMOUS VOTE.

CLERK SACHI HAMAI: ON THE BOTTOM OF PAGE 24, REGIONAL

PLANNING, ITEM 54.

SUP. YAROSLAVSKY, CHAIRMAN: HANG ON. ITEM 54, ANTONOVICH

MOVES, MOLINA SECONDS. UNANIMOUS VOTE.

CLERK SACHI HAMAI: SHERIFF, ITEMS 55 THROUGH 61.
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1 SUP. YAROSLAVSKY, CHAIRMAN: ANTONOVICH MOVES, BURKE SECONDS.

2 UNANIMOUS VOTE.

4 CLERK SACHI HAMATI: TREASURER AND TAX COLLECTOR, ITEM 62 AND

5 63.

7 SUP. YAROSLAVSKY, CHAIRMAN: MOLINA MOVES, BURKE SECONDS.

8 UNANIMOUS VOTE.

10 CLERK SACHI HAMAI: ORDINANCES FOR ADOPTION, ITEMS 64 THROUGH
11 68. AND, ON ITEM 68, THERE'S A REQUEST FROM A MEMBER OF THE
12 PUBLIC TO HOLD THIS ITEM.

13

14 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. SO THE REMAINDER ARE BEFORE
15 Us?

16

17 CLERK SACHI HAMAI: CORRECT.

18

19 SUP. YAROSLAVSKY, CHAIRMAN: BURKE MOVES, I'LL SECOND.

20 UNANIMOUS VOTE.

21

22 CLERK SACHI HAMAI: MISCELLANEOUS, ADDITIONS TO THE AGENDA
REQUESTED BY BOARD MEMBERS AND THE CHIEF ADMINISTRATIVE

OFFICER, WHICH WERE POSTED MORE THAN 72 HOURS IN ADVANCE OF
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1 THE MEETING, AS INDICATED ON THE GREEN SUPPLEMENTAL AGENDA.

2 ITEM 69-A.

4 SUP. YAROSLAVSKY, CHAIRMAN: I'LL MOVE IT. MOLINA SECONDS.

5 UNANIMOUS VOTE.

7 CLERK SACHI HAMAI: 69-B.

9 SUP. YAROSLAVSKY, CHAIRMAN: I'LL MOVE IT. ANTONOVICH SECONDS.
10 UNANIMOUS VOTE.

11

12 CLERK SACHI HAMAI: AND MR. CHAIRMAN, COULD WE GO BACK TO

13 NOTICES OF CLOSED SESSION, ON ITEM CS-2, ON THE SUPPLEMENTAL
14 AGENDA, THERE WAS A REQUEST TO CONTINUE CS-2 ONE WEEK TO APRIL
15 17TH, 2007.

16

17 SUP. YAROSLAVSKY, CHAIRMAN: YOU'RE SURE NOW?

18

19 CLERK SACHI HAMAI: CS-2.

20

21 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. WITHOUT OBJECTION, THAT WILL

22 BE THE ORDER.

23
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1 CLERK SACHI HAMAI: THAT COMPLETES THE READING OF THE AGENDA.
2 BOARD OF SUPERVISORS' SPECIAL ITEMS BEGIN WITH SUPERVISORIAL

3 DISTRICT NUMBER 4.

5 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. I HAVE A PRESENTATION FOR

6 THE CONSUL-GENERAL OF TURKEY, WHO IS LEAVING US. HOW ARE YOU?
7 GOOD TO SEE YOU. TODAY, WE ARE SAYING GOOD-BYE TO THE CONSUL-
8 GENERAL OF TURKEY, THE HONORABLE ENGIN ANSAY, WHO HAS SERVED

9 AS CONSUL-GENERAL IN LOS ANGELES SINCE APRIL OF 2003. CONSUL-
10 GENERAL ANSAY HAS BEEN A VALUED MEMBER OF THE CONSULAR CORPS
11 FOR THE PAST FOUR YEARS, LENDING HIS EXPERIENCE AS A HIGHLY

12 RESPECTED SENIOR DIPLOMAT AND AMBASSADOR IN THE TURKISH

13 FOREIGN SERVICE. CONSUL-GENERAL ANSAY, THANK YOU FOR WORKING
14 CONTINUOUSLY TO STRENGTHEN AND NURTURE THE RELATIONSHIPS

15 SHARED BY OUR TWO COUNTRIES. YOU REPRESENTED YOUR COUNTRY WELL
16 AND I'M SURE THAT THE TURKISH COMMUNITY HERE IN LOS ANGELES --
17 LOS ANGELES COUNTY APPRECIATES ALL THAT YOU'VE DONE DURING

18 YOUR TENURE. I WANT TO PRESENT YOU, ON BEHALF OF THE ENTIRE

19 BOARD, WITH THIS PLAQUE, WHICH EXTENDS OUR BEST WISHES, OUR

20 THANKS FOR YOUR SERVICE HERE IN THE COUNTY AND OUR BEST WISHES
21 IN YOUR FUTURE ENDEAVORS AS YOU MOVE ONWARD AND UPWARD IN THE

22 FOREIGN SERVICE AND IN YOUR PERSONAL LIFE. CONGRATULATIONS AND

23 WE'VE ENJOYED HAVING YOU HERE.
24

25 THE HONORABLE ENGIN ANSAY: THANK YOU VERY MUCH. [ APPLAUSE ]
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THE HONORABLE ENGIN ANSAY: HONORABLE CHATRMAN YAROSLAVSKY,
DISTINGUISHED MEMBERS OF THE BOARD OF SUPERVISORS, THANK YOU
VERY MUCH. I HAD ALMOST 30 YEARS OF MY PUBLIC SERVICE OF 40
YEARS IN THIS BLESSED COUNTRY OF YOURS BUT I MUST SAY, MY
FAMILY AND I, WE HAVE PROFITED AND ENJOYED, HAD THE BEST YEARS
OF OUR ADULT LIVES BUT THE LAST FOUR YEARS, WHEN I HAD THE
HONOR OF SERVING IN CALIFORNIA AND 11 OTHER STATES AS THE
CONSUL-GENERAL OF MY COUNTRY, WAS THE CROWNING POINT IN MY
SERVICE. SO, ON BEHALEF OF MY COUNTRY, ON BEHALEF OF MY CONSULAR
STAFF AND ON MY OWN BEHALF, I'D LIKE TO EXTEND TO YOU AND TO
THE GREAT PEOPLE OF CALIFORNIA MY PROFOUND THANKS AND
GRATITUDE AND WISH YOU THE BEST IN YOUR ENDEAVORS. THANK YOU

VERY MUCH. [ APPLAUSE ]

THE HONORABLE ENGIN ANSAY: THANK YOU VERY MUCH INDEED.

SUP. YAROSLAVSKY, CHAIRMAN: SUPERVISOR ANTONOVICH, YOU'RE UP

NEXT.

SUP. ANTONOVICH: MR. CHAIRMAN, MEMBERS, IT'S AN OPPORTUNITY TO
RECOGNIZE BRYCE YOKOMIZO, WHO IS OUR DIRECTOR OF DEPARTMENT OF
PUBLIC SOCIAL SERVICES UPON HIS RETIREMENT, ALTHOUGH IT'S ONLY
GOING TO BE TEMPORARY BECAUSE HE'S GOING TO BE ONE OF THE

JUNIOR DEPUTY C.A.O.'S RUNNING AROUND HERE IN HIS NIKE SUITS
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1 AND I TOLD HIM HE'S PROBABLY GOING TO GO OUT TO THE ANTELOPE
2 VALLEY FOR THE FIRST FIELD OFFICE TO BE BUILT IN A HIGH-RISE
3 BUILDING BUT, BESIDES THAT, BRYCE HAS SPENT 33 YEARS IN OUR
4 COUNTY OF LOS ANGELES. HE STARTED BACK IN 1974 AND THEN HE

5 WENT ON A FAST TRACK WHERE HE WENT THROUGH 18 PROGRESSIVELY
6 CHALLENGING ASSIGNMENTS, ENDING AS THE CHAIRMAN AND DIRECTOR

7 OF THE DEPARTMENT OF PUBLIC SOCIAL SERVICES IN MARCH OF 2002.
8 THROUGH HIS LEADERSHIP, THEY HAVE REDUCED THE FOOD STAMP ERROR
9 RATE TO THE LOWEST IT HAS EVER BEEN. FOR THE FIRST TWO MONTHS
10 OF FEDERAL FISCAL YEAR 2007, THERE IS A ZERO PERCENT ERROR

11 RATE, WHICH IS AN INCREDIBLE FEAT AND WE APPRECIATE THAT

12 LEADERSHIP. THEY'VE ALSO WORKED TO COORDINATE WITH OTHER

13 AGENCIES. AN EXAMPLE OF THIS IS THEIR LEAD ROLE IN ASSEMBLING
14 THE SKID ROW OUTREACH TEAM, AS WELL AS THE DEVELOPMENT OF

15 SEVERAL WORTHWHILE PROGRAMS TO HELP THE HOMELESS, SUCH AS THE
16 CALWORKS HOUSING LOCATOR, THE 12-MONTH RENTAL SUBSIDY AND THE
17 GENERAL RELIEF HOUSING SUBSIDY AND CASE MANAGEMENT PILOT.

18 KEEPING WITH TECHNOLOGICAL ADVANCES, THE IMPLEMENTED THE

19 CUSTOMER SERVICE CENTER ON JANUARY 16TH OF THIS YEAR. THIS

20 CENTER WILL UTILIZE HIGHLY TRAINED REPRESENTATIVES WHO ADDRESS
21 SPECIFIC CASE INQUIRIES AND ANSWER GENERAL QUESTIONS THROUGH A

22 CENTRALIZED STATE-OF-THE-ART INFORMATION AND TRACKING SYSTEM.

23 AND, IN KEEPING WITH THAT PHILOSOPHY OF PERFORMANCE-BASED
24 ~ MANAGEMENT, BRYCE HAS COMMITTED THE DEPARTMENT TO ACHIEVE THE

25 GOALS OF WORKFORCE EXCELLENCE BY PROVIDING EDUCATIONAL
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1 OPPORTUNITIES FOR HIS EMPLOYEES. THIS INCLUDES HELPING THOSE
2 WITH THE UNDERGRADUATE DEGREES, CREATION OF ON-SITE MASTER'S
3 IN PUBLIC ADMINISTRATION DEGREE PROGRAM AND PERSONAL SUPPORT
4 OF STAFF PARTICIPATION AND MANAGEMENT TRAINING PROGRAMS

5 OFFERED WITHIN THE DEPARTMENT BY THE DEPARTMENT OF HUMAN

6 RESOURCES AND THE SOUTHERN AREA CONSORTIUM OF HUMAN SERVICES.
7 THE DEPARTMENT HAS ALWAYS BEEN AT THE TOP OF THE CHART FOR

8§ AMOUNT OF CONTRIBUTION IT ELECTS FOR CHARITABLE GIVINGS. AND,
9 NOW AT THIS TIME, BRYCE, WE'RE GOING TO GIVE YOU OUR ACADEMY
10 AWARD, PLUS HE'S PROBABLY THE WITTIEST, MOST ENTERTAINING

11 MASTER OF CEREMONIES, JOKESTER, A GOOD MAN AND WE APPRECIATE
12 HIS LEADERSHIP BOTH AT THE BOARD, IN HIS CHURCH, IN HIS

13 COMMUNITY AND NOW WE'RE GOING TO SEE HOW HE FARES AS A LITTLE
14 DEPUTY C.A.O. RUNNING AROUND IN HIS NIKE SHOES SO BRYCE. [

15 APPLAUSE ]

16

17 SUP. MOLINA: MR. CHAIRMAN, IF YOU WOULD PERMIT ME, I'D LIKE TO
18 SHARE A FEW WORDS. I KNOW THERE ARE MANY WHO DISCOVERED THE

19 TALENT AND THE SKILL SET OF BRYCE YOKOMIZO BEFORE I DID BUT I
20 REALLY HAD A TREMENDOUS OPPORTUNITY IN WORKING WITH HIM WHEN
21 WE WERE TAKEN ON MACLAREN AND IT WAS SUCH A WEB OF

22 DISCONNECTED AND REALLY HURTING CHILDREN IN THE LONG RUN. I

23  APPRECIATED HIS LEADERSHIP THEN. HE WAS OUTSTANDING, HE TOOK
24 CONTROL, HE WAS ABLE TO PUT PEOPLE AND ORGANIZE FOLKS IN ORDER

25 AND GET THEM TO DO THE JOBS THAT THEY SHOULD BE DOING AND
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1 HELPING CHILDREN EVERY SINGLE DAY. BUT I GUESS ALL OF US
2 COLLECTIVELY RECOGNIZE HOW VERSATILE AND HOW TALENTED THIS MAN
3 IS WHEN HE TOOK OVER D.P.S.S. AND IT CERTAINLY IS -- WE

4 HAVEN'T WANTED HIM TO GO, I THINK ALL OF US HAVE ASKED HIM TO
5 STAY, BUT HE SAID HE WAS GOING TO MOVE ON. WE'RE KIND OF

6 PLEASED, THOUGH, THAT YOU'RE GOING TO BE BACK WORKING WITH US
7 AT THE C.A.0.'S OFFICE. I THINK, AGAIN, YOUR TALENT, YOUR

8 LEADERSHIP, YOUR ABILITY TO WORK WITH PEOPLE AND BRING THEM

9 TOGETHER IS GOING TO BE A TREMENDOUS ASSET TO ALL OF US AS WE
10 UNDERTAKE THIS DRAMATIC CHANGE IN THE C.A.O0.'S OFFICE. SO

11 WHILE, YOU KNOW, WE'RE DISAPPOINTED THAT YOU'RE RETIRING,

12 WE'RE REALLY HAPPY THAT WE'RE GOING TO SEE YOU AROUND AND GET
13 TO ENJOY MUCH OF WHAT YOU HAVE TO OFFER THE COUNTY.

14 CONGRATULATIONS. YOU'VE DONE A WONDERFUL JOB. [ APPLAUSE ]

15

16 SUP. YAROSLAVSKY, CHAIRMAN: SUPERVISOR BURKE.

17

18 SUP. BURKE: I WOULD JUST LIKE TO ADD HOW MUCH OUR OFFICE HAS
19 ENJOYED WORKING WITH YOU. IT'S BEEN WONDERFUL BECAUSE WE

20 ALWAYS HAD THAT COMMUNICATION. WE WERE ALWAYS ABLE TO RAISE
21 ISSUES THAT WE FELT WERE IMPORTANT AND HE WAS ALWAYS VERY

22 SENSITIVE TO THEM. YOU WERE ALWAYS AWARE OF THE ISSUES IN OUR

23 COMMUNITY AND IN THE SECOND DISTRICT AND REALIZED THAT
24 SOMETIMES, DISPROPORTIONATELY, WE WERE AFFECTED THAN OTHER

25 DISTRICTS IN THE COUNTY OF LOS ANGELES. I'M GLAD YOU'RE
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1 STAYING, TOO. WE CAN'T LOSE YOU RIGHT NOW! I THINK WE HAVE TOO
2 MANY ISSUES THAT WE'RE FACING AND TOO MANY PROBLEMS AT THIS

3 POINT THAT IT'S JUST BETTER THAT YOU'RE HERE AND WE HOPE THAT
4 YOU'LL ALWAYS STAY AND KEEP COMMUNICATION WITH THE COUNTY OF

5 LOS ANGELES BECAUSE WE APPRECIATE YOUR HARD WORK OVER ALL

6 THESE YEARS IN MANY DIFFERENT CAPACITIES. WE RECOGNIZE THAT.

7 BUT HAVE A WONDERFUL RETIREMENT, SUCH AS IT IS.

9 SUP. YAROSLAVSKY, CHAIRMAN: I'D JUST LIKE TO ADD, BRYCE, MY

10 TWO CENTS. THE DEPARTMENT OF PUBLIC SOCIAL SERVICES IS A BOOBY
11 TRAPPED DEPARTMENT AND THERE ARE ANY NUMBER OF ISSUES ON ANY
12 GIVEN DAY THAT CAN BLOW UP IN THE BOARD'S FACE, IN THE

13 DIRECTOR'S FACE AND OVER THE YEARS THAT ALL OF US HAVE WATCHED
14 THE COUNTY, BOTH CLOSELY AND FROM A DISTANCE, D.P.S.S. HAD ITS
15 DAY ON THE FRONT PAGES OF THE NEWSPAPERS AND YOU HAVE-- YOU'VE
16 KEPT D.P.S.S5. OUT OF THE NEWSPAPERS AND HAVE KEPT THE FOCUS ON
17 OUR CLIENTS, THE SEVERAL MILLION CLIENTS THAT DEPEND ON US FOR
18 SO MUCH OF THEIR ABILITY TO CARRY ON IN OUR COUNTY AND YOU'VE
19 DONE IT WITH A COOLNESS, AT LEAST AN OUTER COOLNESS, THAT

20 DEFIES IMAGINATION AND I'VE ENJOYED JUST WATCHING, YOU'RE A

21 PROFESSIONAL, YOU'RE A PRO AND ONE OF THE REAL GREAT ASSETS,

22 UTILITY PLAYER FOR THE COUNTY, AS WE'RE FINDING OUT, BUT

23 YOU'RE CERTAINLY SKILLED IN YOUR SKILLED POSITIONS LIKE NO ONE
24 ELSE. I'VE ENJOYED WORKING WITH YOU, MY STAFF HAS, BOTH THOSE

25 WHO ARE WITH ME AND THOSE WHO HAVE LEFT, AND WE LOOK FORWARD
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1 TO WORKING WITH YOU IN THE WEEKS AND MONTHS AHEAD. [ APPLAUSE

2]

4 BRYCE YOKOMIZO: I APPRECIATE ALL THE KIND WORDS, I APPRECIATE
5 SUPERVISOR ANTONOVICH AND ESPECIALLY THE BOARD OF SUPERVISORS
6 FOR THIS RECOGNITION. AS THE BOARD MEMBERS HAVE INDICATED, THE
7 DEPARTMENT OF PUBLIC SOCIAL SERVICES HAS OVERCOME AN AWEFUL A

8 LOT OF CHALLENGES IN RECENT YEARS AND IT REALLY WAS BECAUSE OF
9 THE SUPPORT THAT THE DEPARTMENT HAS ALWAYS RECEIVED FROM THE
10 BOARD OF SUPERVISORS THAT REALLY HAS MADE THAT POSSIBLE AND

11 THERE HAVE BEEN SOME TIMES WHEN IT'S REQUIRED A LOT OF

12 PATIENCE ON THE PART OF THE BOARD, ENCOURAGEMENT ON THE PART
13 OF THE BOARD AND WE'VE ALWAYS RECEIVED THAT. YOU'VE STOOD BY
14 THIS DEPARTMENT AND I HAVE A GREAT APPRECIATION FOR THAT. OF
15 COURSE, THE WORK TRULY ISN'T DONE BY ME, IT'S DONE BY A LOT OF
16 DEDICATED STAFF AND I THINK THAT'S WHAT I REALLY WANT TO-- THE
17 POINT I'D LIKE TO MAKE THIS MORNING IS THAT OUR SUCCESS REALLY
18 IS BASED VERY MUCH UPON THE DEDICATED STAFF AND THE MANAGERS
19 OF D.P.S.S. THEY'RE JUST SO DEDICATED AND WORK SO VERY, VERY
20 HARD TO MAKE OUR DEPARTMENT'S PERFORMANCE THE BEST THAT IT CAN
21 BE, SO I JUST THANK YOU VERY, VERY MUCH. IT'S BEEN AN ABSOLUTE

22 PRIVILEGE TO SERVE AS YOUR DEPARTMENT HEAD AND I THANK YOU

23 AGAIN. MIKE'S REMINDING ME. I GOT TO MAKE SOME-- I APPRECIATE
24 MY ASSISTANT DIRECTORS THAT ARE HERE AND, OF COURSE, MY WIFE,

25 ROSIE, WHO HAS REALLY BEEN THE ONES WHO SEE-- SHE'S THE ONE
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1 WHO REALLY SEES WHAT IT'S REALLY LIKE TO BE A DEPARTMENT HEAD
2 BECAUSE SHE SEES ME AT HOME WHEN, AS ZEV SAYS, IT'S NOT ALWAYS
3 THAT COOL WHEN I GET HOME IN THE EVENINGS. SO I REALLY

4 APPRECIATE HER. SHE'S TRULY DONE THE HARD WORK. THANKS AGAIN.

5 [ APPLAUSE ]

7 SUP. ANTONOVICH: NOW WE HAVE A LITTLE SIAMESE LONG HAIR. HE'S
8 ONLY SIX WEEKS OLD. HE'S CALLED SMOKEY AND LITTLE SMOKEY IS

9 LOOKING FOR A HOME. AND, BRYCE, THIS IS PART OF THE GOING AWAY
10 PACKAGE. [ LAUGHTER ]

11

12 SUP. ANTONOVICH: ANYWAY, LITTLE SMOKEY IS LOOKING FOR A HOME,
13 SO IF YOU'D LIKE TO ADOPT HIM, IT'S (562) 728-4644. AWWWW. SO
14 PRETTY. YEAH. THANK YOU.

15

16 SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. SUPERVISOR MOLINA.

17

18 SUP. MOLINA: THANK YOU.

19

20 SUP. MOLINA: I AM HONORED THIS MORNING-- I'M HONORED THIS

21 MORNING TO PRESENT TO YOU AND TO WELCOME TO THE BOARD THE

22 GARFIELD HIGH SCHOOL DECATHLON TEAM, WHO PLACED NINTH IN THE

23 CALIFORNIA STATE DECATHLON WHICH WAS RECENTLY HELD HERE IN LOS

24 ANGELES. THE STATEWIDE ACADEMIC DECATHLONS ARE VERY

25 COMPETITIVE WITH OVER A HUNDRED SCHOOLS PARTICIPATING. THESE
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1 YOUNG MEN AND WOMEN WORK MANY HOURS TO PREPARE FOR THESE
2 RIGOROUS EXERCISES. LAST YEAR, THE GARFIELD TEAM PLACED TENTH
3 STATEWIDE. IT'S ONLY FITTING TO PROVIDE PUBLIC RECOGNITION. WE
4 WISH TO CONGRATULATE THE DEDICATED TEAM MEMBERS AS THE SCHOOL
5 CONTINUES TO IMPROVE YEAR AFTER YEAR AND AMASS NATIONAL

6 RECOGNITION. IN FACT, THE TEAM IS CURRENTLY RANKED 17TH

7 NATIONWIDE AND WE'RE VERY PROUD OF THEM. ALSO, THE INDIVIDUAL
8 TEAM MEMBERS PLACED HIGHLY IN VARIOUS COMPETITIVE AREAS,

9 INCLUDING ONE FIRST PLACE FINISH. FOR EXAMPLE, IAN ONDA

10 HUMEL'S SCORE WAS 8,977.6 OUT OF A POSSIBLE 10,000 POINTS IN
11 THE STATE DECATHLON. THAT MAKES IAN NUMBER ONE IN THE STATE OF
12 CALIFORNIA. [ APPLAUSE ]

13

14 SUP. MOLINA: WITH MANY OF THE STATE DECATHLON CONFERENCES,

15 GARFIELD TEAM MEMBERS RANKED FOURTH IN THEIR OWN CONFERENCE

16 GROUP. OVER THE LAST TWO DECADES, THE GARFIELD HIGH SCHOOL

17 SCHOLARS HAVE ACHIEVED AN IMPRESSIVE RANKING OVER 18 TIMES.

18 THE BOARD OF SUPERVISORS ARE SO VERY PROUD TO RECOGNIZE THE

19 GARFIELD HIGH SCHOOL ACADEMIC DECATHLON, THE MIGHTY BULLDOGS
20 AS THEY LIKE TO BE RECOGNIZED, WHO CONTINUE TO MAKE OUR

21 COMMUNITY IN THE EAST L.A. SO VERY PROUD. I REMEMBER WHEN WERE

22 MANY WHO WEREN'T AS PROUD TO COME FROM EAST L.A. AS THEY

23 SHOULD HAVE BEEN BUT GARFIELD IS ONE OF THOSE INSTITUTIONS
24 THAT, THROUGH THE YEARS, HAS IMPROVED AND DONE SO VERY WELL.

25 I'D LIKE TO FIRST OF ALL MAKE A PRESENTATION TO THE GARFIELD
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1 HIGH SCHOOL. THEY ARE JOINED, BY THE WAY, I'VE GOT TO POINT
2 THAT OUT BECAUSE THEY DIDN'T DO IT ALL BY THEMSELVES. THEY HAD
3 WONDERFUL COACHES AND I WANT TO INTRODUCE THEM. THE DECATHLON
4 COACHES INCLUDE JOHN BENNETT, LUCY ROMERO, ZOE SOCILAS FOLEY,
5 IS SHE HERE? OH, BUT SHE'S ALSO ONE OF THEM. ELSA SAPIEN, ANDY
6 DAVIS AND KEVIN MURCHY. THESE ARE THE GREAT COACHES, THE

7 TEACHER WHO LED THIS TEAM ON TO VICTORY. WHY DON'T YOU COME UP
8 AND I WOULD LIKE-- WHO'S GOING TO SHARE SOMETHING WITH US?

9 WOULD YOU LIKE TO START? GO AHEAD.

10

11 SPEAKER: I JUST WANT TO THANK THE COUNTY BOARD OF SUPERVISORS
12 AND SUPERVISOR MOLINA TO RECOGNIZE US. IT'S NICE TO BE FROM

13 GARFIELD HIGH SCHOOL AND TO BE RECOGNIZED. WE WORK VERY HARD,
14 WE WORK AFTER SCHOOL UNTIL 7:00 EVERY NIGHT, WE WORK ON

15 SATURDAYS, AND THESE KIDS IN BACK OF ME HAVE GIVEN UP A BIG

16 PART OF THEIR LIVES OVER THE LAST YEAR TO DO WHAT THEY'VE BEEN
17 ABLE TO DO, SO THANK YOU VERY MUCH. IT'S WONDERFUL TO BE

18 RECOGNIZED BY YOU.

19

20 SUP. MOLINA: AND VERY DESERVING. [ APPLAUSE ]

21

22 SUP. MOLINA: I'M GOING TO PRESENT A CERTIFICATE TO EACH OF

23 THEM. I HOPE THEY'RE ALL HERE. NOT ALL OF THEM COULD BE HERE.
24 FIRST OF ALL, ELIAS VELTRANE. CONGRATULATIONS, ELIAS. [

25  APPLAUSE ]
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2 SUP. MOLINA: TAKE A PICTURE. OF COURSE WE HAVE IAN, FIRST

3 PLACE WINNER. [ APPLAUSE ]

5 SUP. MOLINA: THEN WE HAVE LAURA POIRAS. LAURA? [ APPLAUSE ]

7 SUP. MOLINA: THEN WE HAVE JOSEPH MENESES. JOSEPH? [ APPLAUSE ]

9 SUP. MOLINA: FOLLOWED BY VICTOR MONTECINOS. VICTOR? [ APPLAUSE
10 ]

11

12 SUP. MOLINA: ALL RIGHT. CARMEN VASSO. CARMEN? [ APPLAUSE ] [
13 LAUGHTER ]

14

15 SUP. MOLINA: GREGORY RAMPIO. GREGORY? [ APPLAUSE ]

16

17 SUP. MOLINA: LEE VALENCIA. [ APPLAUSE ]

18

19 SUP. MOLINA: LEESET VAHALA. CONGRATULATIONS. [ APPLAUSE ]

20

21 SUP. MOLINA: AND AS FAR AS I HAVE THEM ALSO FOR THE TWO

COACHES, JOHN BENNETT, CONGRATULATIONS, SIR. [ APPLAUSE ]

SUP. MOLINA: AND THEN ONE FOR LUCY AS WELL. LUCY ROMERO.

CONGRATULATIONS. [ APPLAUSE ]
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14

15

16
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18

19

20

21

SUP. MOLINA: WE'RE GOING TO DO A GROUP SHOT. WOULD YOU JOIN ME
IN THANKING ALL OF THEM. THEY DID SUCH AN OUTSTANDING JOB. [

CHEERS AND APPLAUSE ]

SUP. MOLINA: CONGRATULATIONS. YOU MAKE US VERY PROUD. THANK

YOU SO MUCH.

SUP. YAROSLAVSKY, CHAIRMAN: GLORIA, YOU DONE?

SUP. MOLINA: YES, I'M FINISHED. THANK YOU.

SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. SUPERVISOR BURKE, I'M

SORRY .

SUP. BURKE: I'D LIKE TO CALL FORWARD THE COUNTY LIBRARIAN,
MARGARET DONLAN TODD. DURING THE WEEK OF APRIL 15TH THROUGH
THE 21ST, THE COUNTY OF LOS ANGELES PUBLIC LIBRARY, THE
LIBRARY PROFESSION AND THE PUBLIC WILL CELEBRATE NATIONAL
LIBRARY WEEK. OUR NATION'S LIBRARIES ARE TRULY A NATIONAL
TREASURE AND I'M PLEASED THAT THE COUNTY OF LOS ANGELES PUBLIC
LIBRARY WORKS WITH COMMUNITIES THROUGHOUT THE COUNTRY, AS WELL
AS THROUGHOUT THE COUNTY, PROVIDING ACCESS TO CULTURE,
LITERACY AND LIFELONG LEARNING. ON BEHALEF OF THE BOARD OF

SUPERVISORS, I DECLARE APRIL 15TH THROUGH THE 21ST AS NATIONAL
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1 LIBRARY WEEK IN THE COUNTY OF LOS ANGELES AND URGE THE PUBLIC
2 TO VISIT THEIR LIBRARY, GET TO KNOW YOUR LIBRARY, EXPLORE THE
3 MATERTIALS AND TAKE ADVANTAGE OF THE SERVICES THAT THE

4 COMMUNITY LIBRARY OFFERS, NOT ONLY DURING NATIONAL LIBRARY

5 WEEK BUT ALSO THROUGHOUT THE YEAR. AND WE'D LIKE TO PRESENT

6 THIS TO OUR LIBRARIAN. CONGRATULATIONS. [ APPLAUSE ]

¢ MARGARET DONLAN TODD: THANK YOU, SUPERVISOR BURKE. I WANT TO
9 THANK THE BOARD FOR THEIR VERY STRONG SUPPORT OF THE PUBLIC
10 LIBRARY IN LOS ANGELES COUNTY AND TO ENCOURAGE EVERYONE, IF
11 YOU AREN'T CURRENTLY USING THE LIBRARY, TO GET TO THE LIBRARY
12 OR TO GO ONLINE AND LOOK AT THE SERVICES THAT WE ALSO OFFER
13 ONLINE. WE'RE PARTICULARLY PROUD THIS YEAR OF OUR LIVE

14 HOMEWORK HELP FOR CHILDREN, OUR FAMILY LITERACY, OUR EMERGENT
15 LITERACY FOR VERY YOUNG CHILDREN. SO COME INTO YOUR LIBRARY,
16 IT'S-- PROBABLY, IF YOU HAVEN'T BEEN THERE IN AWHILE, YOU

17 WON'T RECOGNIZE ALL THE WONDERFUL CHANGES.

18

19 SUP. BURKE: THANK YOU SO MUCH. NOW WE'RE REALLY GOING TO HAVE
20 A VERY UNIQUE OPPORTUNITY. I'M GOING TO GIVE YOU SOME

21 BACKGROUND THEN I'M GOING TO GO DOWN TO MAKE THIS
PRESENTATION. TOMMIE WALL, BORN IN 1903, CELEBRATED HIS 104TH

BIRTHDAY ON MARCH 30TH. CONGRATULATIONS. [ APPLAUSE ]

The Meeting Transcript of
The Los Angeles County Board of Supervisors
25




April 10, 2007

The Meeting Transcript of
The Los Angeles County Board of Supervisors

—_

SUP. BURKE: HE'S THE YOUNGEST OF FIVE CHILDREN AND THE ONLY
2 BOY. HE SETTLED HERE IN CALIFORNIA WITH HIS WIFE AND SIX

3 CHILDREN IN THE LATE '50S FROM ARKANSAS. HE HAS 16

4 GRANDCHILDREN, 35 GREAT-GRANDCHILDREN AND 18 GREAT, GREAT-
5 GRANDCHILDREN. HE COULD POSSIBLY BE THE LONGEST LIVING

6 AFRICAN-AMERICAN IN LOS ANGELES COUNTY. IT'S WITH GREAT

7 PLEASURE THAT I PRESENT THIS SCROLL AND I'M GOING TO GO DOWN

8 AND PRESENT IT TO HIM ON HIS 104TH BIRTHDAY. WE AREN'T GOING

9 TO ASK HIM TO COME UP HERE. IT'S MY PLEASURE TO WISH MR. WALL,
10 TOMMIE WALL, A VERY, VERY HAPPY BIRTHDAY. BORN IN CLARENDON,
11 ARKANSAS MARCH 30TH, 1903 AND MANY, MANY HAPPY RETURNS TO YOU.
12 [ APPLAUSE ]

13

14 SPEAKER: HI, ON BEHALF OF THE FAMILY, WE'D LIKE TO THANK

15 SUPERVISOR BURKE AND THE BOARD OF SUPERVISORS FOR CELEBRATING
16 AND RECOGNIZING OUR GRANDFATHER, TOMMIE WALL, AND HE IS A

17 BELOVED FATHER, GRANDFATHER, UNCLE, GREAT GRANDFATHER AND

18 MANY, MANY LOVED ONES, THANK YOU VERY MUCH. TO GOD BE THE

19 GLORY.

20

21 SUP. BURKE: ALL RIGHT. WE'RE GOING TO TAKE A PHOTO. I'M IN
YOUR WAY. LET ME JUST GET RIGHT HERE. THANK YOU VERY MUCH AND

MANY MORE RETURNS.

SUP. YAROSLAVSKY, CHAIRMAN: HAPPY BIRTHDAY.
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SUP. BURKE: WE'D LIKE TO CALL FORTH MARGARET DUALLY, PROP 36
COORDINATOR FOR DRUG POLICY ALLIANCE AND PROP 36 GRADUATES. [

WHISTLES ] [ CHEERS AND APPLAUSE ]

SUP. BURKE: OVER 18,000 RESIDENTS OF LOS ANGELES COUNTY
SUCCESSFULLY COMPLETE SUBSTANCE ABUSE TREATMENT AND ARE ON THE
ROAD TO LONG-TERM RECOVERY THANKS TO THE TREATMENT THEY'VE
RECEIVED UNDER PROPOSITION 36, THE 6-YEAR-OLD VOTER ENACTED
TREATMENT INSTEAD OF INCARCERATION LAW. THESE GRADUATES ARE
PROOF THAT ADDICTION IS TREATABLE AND THAT LONG-TERM RECOVERY
FROM DRUG AND ALCOHOL ADDICTION RESTORES HOPE, REBUILDS LIVES
AND REBUILDS FAMILIES. BY CHOOSING TREATMENT INSTEAD OF JAIL
TIME, THE GRADUATES HAVE HELPED TO SAVE STATE TAXPAYERS AT
LEAST $850 MILLION IN JUST 5 YEARS. ON BEHALF OF THE BOARD OF

SUPERVISORS... [ APPLAUSE ]

SUP. BURKE: ...I PROCLAIM APRIL 8TH, 2007, AS PROP 36
GRADUATES DAY AND CALL UPON RESIDENTS TO PROMOTE THE BENEFITS
OF DRUG AND ALCOHOL TREATMENT PROGRAMS. I'M GOING TO ASK THE

GRADUATES TO STAND. [ APPLAUSE ]

SUP. BURKE: AND THE PEOPLE WHO ARE PART OF THE PROGRAM. [

APPLAUSE ] [ CHEERS AND APPLAUSE ]
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1 SUP. BURKE: MAYBE WE SHOULD GET A PICTURE FIRST, THEN YOU CAN

2 SAY SOMETHING, THEN WE'LL GET A PICTURE WITH EVERYBODY.

4 MARGARET DUALLY: THANK YOU, SUPERVISOR BURKE, FOR THIS

5 RECOGNITION. IT'S SO IMPORTANT THAT, AFTER ALL THE HARD WORK

6 OF THESE GRADUATES, THAT THEY BE RECOGNIZED. 18,000 PEOPLE IN
7 THE COUNTY HAVE GRADUATED FROM PROP 36 AND GONE ON TO BE MORE
8 PRODUCTIVE, HAPPIER MEMBERS OF THE COMMUNITY HERE AND BETTER

9 MEMBERS OF THEIR OWN FAMILIES. THEY-- ALONE, THE 18,000 IN

10 L.A. COUNTY HAVE SAVED OVER $51 MILLION SO THIS IS A PROGRAM
11 THAT SAVES LIVES AND SAVES MONEY. WHAT'S NOT TO LIKE? THANK

12 YOU. WE HAVE SEVERAL GRADUATES BEHIND ME AND NORMA JEAN SCOTT,
13 ONE OF OUR MOST AMAZING L.A. COUNTY GRADUATES, HAS A FEW WORDS
14 TO SHARE WITH HER STORY.

15

16 NORMA JEAN SCOTT: GOOD MORNING. MY NAME IS NORMA JEAN AND I'VE
17 BEEN IN RECOVERY SINCE JULY 17, 2005. I HAVE 21 MONTHS CLEAN
18 AND SOBER. [ CHEERS AND APPLAUSE ]

19

20 NORMA JEAN SCOTT: THANK YOU. ON JUNE 21ST, 2005, I WAS

21 REFERRED TO CHOICES FOR PROPOSITION 36 SERVICES. I BECAME

22 CLEAN AND SOBER, MOVED OUT OF HOMELESSNESS TO URDC'S

23 TRANSITIONAL LIVING FACILITY AND STARTED TAKING CARE OF MY
24 PHYSICAL HEALTH THAT I HAD NEGLECTED FOR DECADES THROUGH THE

25 BILL MOORE COMMUNITY HEALTH CLINIC. ON NOVEMBER 23RD, 2005, I
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1 QUIT SMOKING CIGARETTES. I'M LEARNING TO GIVE BACK TO THE

2 COMMUNITY. [ APPLAUSE ]

4 NORMA JEAN SCOTT: THE 12-STEP TEACHES US TO GIVE BACK TO THE
5 COMMUNITY AND I'M INVOLVED IN THE AMERICAN CANCER SOCIETY

6 RELAY FOR LIFE IN PASADENA. MY VOLUNTEER RESPONSIBILITY IS

7 THAT OF TEAM DEVELOPMENT CHAIR. I AM A STUDENT AND I'VE

8 RECENTLY COMPLETED MEDICAL TERMINOLOGY AND FRONT OFFICE

9 PROCEDURES AND I AM NOW DOING BILLING AND CODING. I'M WORKING
10 TOWARDS MY DEGREE IN BILLING AND CODING AND I WOULD LIKE TO
11 THANK CHOICES, CASA MARIA AND THE BILLMORE COMMUNITY HEALTH
12 CLINIC FOR STANDING BY ME AND HELPING ME GROW. AND I WOULD

13 ALSO LIKE TO THANK PROPOSITION 36 AND COMMISSIONER SERIO OUT
14 OF PASADENA COURT FOR... [ APPLAUSE ]

15

16 NORMA JEAN SCOTT: ...UNDERSTANDING THAT JAIL DOESN'T WORK AND
17 TREATMENT IS POSSIBLE. AND THANK YOU, BOARD OF SUPERVISORS,

18 FOR RECOGNIZING PROPOSITION 36 AS A BETTER ALTERNATIVE THAN
19 JAIL. AND, AS A PRODUCTIVE MEMBER OF SOCIETY, I WILL BE ABLE
20 TO PAY BACK THE CITIZENS OF LOS ANGELES AND THE STATE OF

21 CALIFORNIA THE MONEY SPENT TO GIVE ME THIS OPPORTUNITY TO SAVE
22 MY LIFE. THANK YOU FOR NOT SENDING ME TO PRISON FOR EIGHT

YEARS. [ CHEERS AND APPLAUSE ]
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1 DR. BRUCE CHERNOF: YOU ARE A GREAT SOURCE OF HOPE AND

2 INSPIRATION FOR EVERYBODY THAT HAS A DRUG-RELATED PROBLEM AND
3 WHAT WE NEED IN OUR COMMUNITIES IS TO SUPPORT YOU ON YOUR

4 IMPORTANT PATH TOWARDS LIFELONG SOBRIETY AND THAT INCLUDES

5 EMPLOYERS AS YOU LOOK FOR JOBS TO MAKE SURE THAT THEY

6 UNDERSTAND THAT YOU'RE ON A PATH THAT CAN REALLY BE HELPFUL TO
7 SOCIETY AS WELL AS TO YOURSELF. SO, AGAIN, CONGRATULATIONS AND
8 KEEP UP THE WONDERFUL WORK AND LET'S REMEMBER, THIS IS A

9 CHRONIC PROBLEM, IT TAKES FIGHTING EVERY DAY AND YOU'RE LIVING
10 PROOF THAT YOU CAN WIN. [ CHEERS AND APPLAUSE ]

11

12 SUP. BURKE: THAT CONCLUDES MY PRESENTATIONS.

13

14 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. WE HAVE THE AGENDA NOW

15 BEFORE US. MS. BURKE, YOU'RE UP FIRST. OH, FOURTH DISTRICT IS
16 UP FIRST. I'M SORRY. I HAVE ONE ADJOURNING MOTION TO READ ON
17 BEHALEF OF SUPERVISOR KNABE. MOVE THAT WE ADJOURN TODAY IN THE
18 MEMORY OF VERA GAMBOA, MOTHER OF ROSALIE DURAN, WHO PASSED

19 AWAY ON FRIDAY. VERA WAS LOVED DEARLY BY JOE AND ROSALIE AND
20 WILL BE MISSED BY EVERYONE THAT KNEW HER. SHE IS SURVIVED BY A
21 NUMBER OF RELATIVES AND UNANIMOUS VOTE ON THAT. SUPERVISOR

22 ANTONOVICH.

23
24  SUP. ANTONOVICH: FIRST, I'D LIKE TO MAKE THE FOLLOWING

25  ADJOURNMENT MOTIONS. BURT TOPPER PASSED AWAY AT THE AGE OF 78.
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1 HE WAS A GOOD FRIEND, A SUPPORTER OF MINE. HE WAS A FILM
2 DIRECTOR/PRODUCER. HE PASSED AWAY ON APRIL 10TH. HE WAS BORN

3 IN NEW YORK IN 1928. HE MOVED TO LOS ANGELES AND, ACCORDING TO
4 THE ALL MOVIE GUIDE, HE WAS ONE OF THE GREAT NEAR GENIUSES FOR
5 HIS ABILITY TO PRODUCE LOW BUDGET MOTION PICTURES. DURING

6 WORLD WAR II, HE DID SERVE IN THE UNITED STATES NAVY IN THE

7 PACIFIC. FORMER ASSEMBLYMAN, FLOYD WAKEFIELD, PASSED AWAY AT

8 THE AGE OF 87. HE LEAVES HIS WIFE, RUTH, OF 67 YEARS AND HIS

9 DAUGHTERS, MARY AND JOAN. HE WAS QUITE INVOLVED. HE WAS A

10 SMALL BUSINESSMAN, HAD A ATHLETIC STORE, SPORTING GOODS STORES
11 IN THE CITY OF SOUTHGATE WHEN HE WAS ELECTED TO THE CALIFORNIA
12 STATE LEGISLATURE. HE WAS A REPUBLICAN AND HE WAS ELECTED IN A
13 REGISTRATION OF ABOUT 23%, WHICH WAS COMPARABLE TO FORMER

14 ASSEMBLYMAN PAUL BENAI, WHO WAS THE FIRST NISEI ELECTED TO THE
15 CALTFORNIA STATE LEGISLATURE WHO REPRESENTED GARDENA AND HE

16 WAS ALSO ELECTED IN AN AREA THAT HAD A 23% REPUBLICAN

17 REGISTRATION YET THEY WERE SUCCESSEFUL IN THEIR EFFORTS. HE

18 WORKED WITH HOWARD JARVIS AND THE FORMER GOVERNOR GEORGE

19 DUKMACHIAN ON MANY POLICY ISSUES. CHARLES CROSBY, A SENIOR

20 PASTOR OF THE NEW LIFE CHURCH OF THE NAZARENE IN LANCASTER

21 PASSED AWAY. HE WAS ALSO RESPONSIBLE FOR THE LANCASTER

22 CHRISTIAN SCHOOL AS A PROFESSOR. PASTOR CROSBY TAUGHT URBAN

23 MINISTRY, HE TRAINED CLERGY AT THEOLOGICAL SCHOOLS AND
24 PUBLISHED WRITINGS ON CHRIST-CENTERED SPIRITUALITY AND STUDIED

25 AS-- HE WAS A DOCTORATE CANDIDATE AT FULLER THEOLOGICAL
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1 SEMINARY WHEN HE PASSED AWAY. HE SERVED AS A UNITED STATES
2 NAVY CHAPLAIN COMMANDER IN LONG BEACH AND ESTABLISHED THE

3 EARTHEN VESSEL MINISTRY TO HELP PEOPLE FROM DYSEFUNCTIONAL AND

4 ABUSIVE HOMES. PASSED AWAY ON MARCH 31ST. DEPUTY SHERIFF

5 DONALD SHELLY, HE HAD RETIRED IN 1996 AND HIS LAST ASSIGNMENT

6 WAS AT THE INMATE RECEPTION CENTER. JULIUS YALE LIBOW, HE WAS

7 THE LAST OF CALIFORNIA'S NON-LAW SCHOOL TRAINED JUVENILE COURT
8 REFEREES. HE WAS LIEUTENANT JUNIOR GRADE IN THE UNITED STATES

9 NAVY, A BERKELEY SOCIOLOGY GRADUATE, PROBATION OFFICER AND

10 U.C.L.A. LAW PROFESSOR. HE NEVER ATTENDED LAW SCHOOL BUT HE

11 TAUGHT AT THE LAW SCHOOL AND HE SPENT 35 YEARS WITH THE COURT

12 AND HE INTRODUCED MEDIATION DURING THE 1980S. HE WAS

13 RESPONSIBLE FOR CREATING THE FEDERALLY FUNDED COURT-APPOINTED

14 SPECIAL ADVOCATE PROGRAM AND HE WORKED TO MAKE THE JUVENILE

15 COURT SYSTEM WORK FOR THE BENEFIT OF THE CHILD. HE PASSED AWAY
16 ON MARCH 15TH. AND JAY KOCH, IN MEMORY OF JAY. THOSE ARE MY...
17

18 SUP. YAROSLAVSKY, CHAIRMAN: UNANIMOUS VOTE.

19

20 SUP. ANTONOVICH: ...AND ONE OTHER. TERRY DOUGLAS TULY, WHO WAS
21 A-- DURING THE PAST 33 YEARS, HE WAS PROBATION OFFICER FOR THE

22 COUNTY OF LOS ANGELES FOR THE IMMACULATE CONCEPTION CHURCH. HE

23 SERVED AS A MINISTER FOR HOUSEBOUND ELDERLY AND THE CHILDREN'S

24 LITURGY. HE SERVED IN THE UNITED STATES ARMY AS A MILITARY

25 INTELLIGENCE OFFICER AT THE PENTAGON AND WAS A VIETNAM VETERAN
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1 AND HE PASSED AWAY ON APRIL 3RD. THOSE ARE MY ADJOURNMENT
2 MOTIONS. AND, FOR NEXT WEEK, I WOULD LIKE TO MOVE THAT THE

3 BOARD DIRECT THE C.A.O0. TO PREPARE A 5-SIGNATURE LETTER TO THE
4 HOUSE SUBCOMMITTEE ON INFORMATION POLICY CENSUS AND NATIONAL

5 ARCHIVES, URGING RESTORATION OF FOSTER CHILD CATEGORY IN THE

6 2010 CENSUS TO DEMONSTRATE OUR COMMITMENT TO ABUSED AND

7 NEGLECTED CHILDREN. MR. CHAIRMAN, BECAUSE THIS IS -- IT WOULD

8 HAVE TO GO ON THE AGENDA FOR NEXT WEEK.

10 SUP. YAROSLAVSKY, CHAIRMAN: THAT WILL BE THE ORDER.

11

12 SUP. ANTONOVICH: OKAY. ITEM NUMBER 1-H. WE HAVE CARLOS

13 JACKSON.

14

15 SUP. YAROSLAVSKY, CHAIRMAN: CARLOS JACKSON.

16

17 SUP. ANTONOVICH: THE QUESTIONS I HAD ARE RELATIVE TO THE COST
18 OF $296,000 FROM THE HOUSING CHOICE VOUCHER ADMINISTRATIVE

19 PROGRAM. THE QUESTION, HOW MANY PEOPLE WOULD BE WORKING IN THE
20 SECTION 8 HOUSE OFFICE IN PALMDALE?

21

22  CARLOS JACKSON: WE HAVE APPROXIMATELY-- WE DOWNSIDED TO ABOUT

23 12 STAFF PEOPLE FOR THE TEMPORARY PERIOD OF TIME UNTIL T
24 FINISH THE REORGANIZATION OF THAT OPERATION.

25
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SUP. ANTONOVICH: SO WE'RE TALKING ABOUT 12 PEOPLE?

—_

3 CARLOS JACKSON: RIGHT.

5 SUP. ANTONOVICH: AND IS THIS THEN A RELOCATION OF EXISTING

6 EMPLOYEES?

8§ CARLOS JACKSON: YES, THE EXISTING EMPLOYEES.

10 SUP. ANTONOVICH: WERE SEVERAL EMPLOYEES IN THE OFFICE RECENTLY
11 REASSIGNED TO THE SANTA FE SPRINGS OFFICE?

12

13 CARLOS JACKSON: POSITIONS WERE REASSIGNED TO THE SANTA FE

14 SPRINGS OFFICE.

15

16 SUP. ANTONOVICH: AND WHAT WAS THE COST FOR THAT REASSIGNMENT?
17

18 CARLOS JACKSON: THERE WAS NO COST OF THE REASSIGNMENT OF THAT
19 STAFFE'.

20

21 SUP. ANTONOVICH: AND WHY IS THERE A COST FOR THIS

22 REASSIGNMENT?

23
24 CARLOS JACKSON: SUPERVISOR, WHEN WE HAVE A CURRENT LEASE THAT

25 IS EXPIRING AND THE CURRENT LANDLORD IS NOT RENEWING THE
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1 LEASE, WE HAVE CURRENTLY 3,200 SQUARE FEET THERE AND WE'RE
2 MOVING TO ONE THAT IS 9,800 SQUARE FEET. IT IS FOR MORE

3 CUSTOMER SERVICE BETTER OPERATION. WE WERE TOO CROWDED IN THE
4 ONE FACILITY. WE HAVE APPROXIMATELY ABOUT 3,000 SECTION 8

5 CONTRACTS IN THE ANTELOPE VALLEY. INSPECTORS, OUR

6 INVESTIGATORS, OUR ADMINISTRATIVE STAFF, SO IT JUST CREATES A

7 BETTER WORKING ENVIRONMENT FOR THEM.

9 SUP. ANTONOVICH: OF THE $296,000 REQUESTED, $62,000 IS FOR NEW
10 FURNITURE.

11

12 CARLOS JACKSON: IT'S FURNITURE FOR THE COMMON AREAS, THE

13 CONFERENCE ROOM, BECAUSE WE DON'T HAVE CURRENTLY A CONFERENCE
14 ROOM. ALSO, WE DON'T HAVE A RECEPTION AREA. MOST OF OUR

15 CLIENTS CURRENTLY WAIT IN THE EXTERIOR OF THE OFFICE. WE HAVE
16 JOINT FACILITIES WITH VOCATIONAL SCHOOL THERE AND THE

17 COMPLAINTS THAT WE GOT IS THAT OUR CLIENTS WERE BASICALLY

18 HANGING OUT IN THE CORRIDOR.

19

20 SUP. ANTONOVICH: IF THERE ARE FEWER EMPLOYEES IN THE NEW

21 LOCATION, WHY WOULD THE AUTHORITY NEED MORE MONEY FOR

22 ADDITIONAL FURNITURE?

23
24 CARLOS JACKSON: THE FURNITURE IS PREDOMINANTLY, AGAIN, FOR THE

25 CONFERENCE ROOM, THE RECEPTION AREA. WE ARE USING OUR EXISTING
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1 FURNITURE BEING TRANSFERRED OVER TO THE NEW LOCATION. THE ONLY
2 THING THAT WE'RE BUYING FOR THE-- I MEAN FOR THE EMPLOYEES ARE

3 NEW DESKTOPS, NOT DESKS BUT JUST THE DESKTOPS.

5 SUP. ANTONOVICH: AND DID WE REVIEW WHAT WAS IN THE SURPLUS
6 FURNISHING WAREHOUSE AS IF THERE'S ANY FURNITURE THERE THAT

7 WOULD BE ABLE TO BE ABLE TO BE UTILIZED?

9 CARLOS JACKSON: IF I CAN DEFER THAT TO BOBETTE GLOVER, MY

10 ASSISTANT EXECUTIVE DIRECTOR.

11

12 BOBETTE GLOVER: SUPERVISOR ANTONOVICH, YES, WE REVIEWED, WE DO
13 HAVE A INVENTORY OF OFFICE FURNITURE. YOU KNOW, WE USE THE

14 STANDARD WORK STATIONS, THE PANELS, AND WE HAVE SURVEYED WHAT
15 WE HAVE AND THERE ISN'T SUFFICIENT WORK STATIONS FOR THE STAFF
16 AND IT'S MAINLY THE DESKTOP SURFACES THAT WE'RE PURCHASING.

17 THEY DON'T HAVE ENOUGH WORK AREA ON THEIR DESK. THE MAJOR PART
18 OF THE COST, IF I MIGHT ADD, IS FOR CABLING FOR THE TELEPHONE
19 SYSTEM AND THE COMPUTER SYSTEM. THAT'S APPROXIMATELY 137,000
20 OF THE $296,000.

21

22 SUP. ANTONOVICH: THE BOARD APPROVED 114,000 IN OCTOBER OF 2006

23 FOR TENANT IMPROVEMENTS. WHY WOULDN'T THE COST OF FURNITURE BE

24 INCLUDED AT THAT APPROPRIATION TIME?

25
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1 BOBETTE GLOVER: AT THAT TIME, THE COST WAS FOR-- THE FURNITURE
2 FIXTURES AND EQUIPMENT WAS UNKNOWN AND SO THE $114,000 THAT

3 WAS APPROVED WAS TO BE ADDED TO THE TENANT IMPROVEMENTS AND

4 THOSE WERE FOR EXPENSES AND FOR IMPROVEMENTS THAT THE LANDLORD
5 WAS GOING TO MAKE AND THAT INCLUDED THINGS LIKE BUILDING WALLS
6 FOR OFFICES, FINISHING OUT THE RESTROOMS, ADDING WINDOWS. IT'S
7 A BUILDING WITH VERY FEW WINDOWS AT THIS TIME, SO THE

8 ELECTRICAL HVAC AND OTHER IMPROVEMENT LIKE THAT.

10 SUP. ANTONOVICH: THE 137,000 FOR TELECOM COSTS, THE CABLING,

11 TELEPHONE NETWORK, IS THAT DONE BY THE COUNTY OR DO WE

12 CONTRACT THAT OUT FOR-- HOW DO WE DO THAT?

13

14 BOBETTE GLOVER: WE'LL CON-- I THINK WE'RE GOING TO CONTRACT

15 THAT OUT. IT'S NOT DONE BY THE COUNTY AT ALL. IT WOULD BE DONE
16 UNDER THE SUPERVISION OF THE COMMUNITY DEVELOPMENT COMMISSION.
17

18 SUP. ANTONOVICH: AND WHO DOES THAT?

19

20 BOBETTE GLOVER: I.T. STAFF.

21

SUP. ANTONOVICH: IS THAT LIKE A VERIZON OR ONE OF THOSE TYPE

OF COMPETITORS? WHO...?
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1 BOBETTE GLOVER: YOU KNOW, I'M NOT CERTAIN WHO IS GOING TO DO
2 IT. T DON'T KNOW IF WE'VE GONE OUT TO BID ON IT YET BUT IT

3 WILL BE DONE TO OUR SPECIFICATIONS. YEAH.

5 SUP. ANTONOVICH: THANK YOU.

7 SUP. YAROSLAVSKY, CHAIRMAN: I HAVE ONE ADDITIONAL QUESTION,

8 CARLOS. THE HOUSING AUTHORITY IS CURRENTLY REQUESTING $300,000
9 TO PROCURE HOUSING LOCATOR SERVICES TO HELP PROSPECTIVE

10 SECTION 8 VOUCHER RECIPIENTS TO FIND SUITABLE HOUSING. AT A
11 TIME WHEN YOU ARE ASKING FOR ADDITIONAL MONEY FROM THE BOARD
12 BECAUSE YOU DON'T HAVE THE MONEY IN YOUR BUDGET TO HELP THE
13 PEOPLE THAT YOU NEED TO HELP, DIRECT SERVICES, THE MISSION OF
14 THE DEPARTMENT, IT MAKES SENSE TO CONSIDER THIS-- NEXT WEEK,
15 WE HAVE THE OTHER ITEM COMING UP?

16

17 CARLOS JACKSON: YES.

18

19 SUP. YAROSLAVSKY, CHAIRMAN: IS THERE ANY TIME SENSITIVITY TO
20 THIS? CAN IT WAIT A WEEK?

21

22 CARLOS JACKSON: YEAH, WE CAN WAIT A WEEK ON THIS BUT I COULD

23  ATTEMPT TO ANSWER YOUR QUESTION AS WELL.
24

25 SUP. YAROSLAVSKY, CHAIRMAN: GO AHEAD.
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CARLOS JACKSON: WE HAVE HAD THIS IN THE PLANNING FOR OVER A
YEAR BECAUSE OF THE CURRENT CONDITIONS THAT OUR STAFEF IS UNDER
AT ANTELOPE VALLEY. THIS IS THE ONLY SATELLITE OFFICE THAT WE
HAVE IN OUR PROGRAM AND WE'RE TRYING TO IMPROVE THE CUSTOMER
SERVICE UP THERE. WE HAVE CURRENTLY 3,200 SQUARE FEET WITH 23
STAFF PEOPLE. EVEN THOUGH WE'VE REDUCED THAT TO 12, IT STILL
IS A VERY CRAMPED QUARTERS FOR THE STAFEF TO OPERATE WITH THE
AMOUNT OF CLIENTS THAT WALK INTO OUR OFFICE THERE. WE HAVE
APPROXIMATELY 3,000 CONTRACTS UP THERE AND THERE'S A LOT OF
INTERACTION WITH LANDLORDS, HEARINGS THAT WE CONDUCT, AND THE
CLIENTS THEMSELVES. SO WE HAVE BEEN THINKING ABOUT, FOR SOME
PERIOD OF TIME, WHAT TO DO ABOUT THAT LOCATION. IT WAS
PROMPTED BY THE FACT THAT THE EXISTING LANDLORD IS NOT GOING
TO RENEW THE LEASE, SO WE DO HAVE TO FIND SPACE FOR THE STAFF.
AND THEN, SECONDLY, WHEN WE DID LOOK AT THE VARIOUS LOCATIONS,
THIS CAME TO OUR ATTENTION AS A REFERRAL FROM THE C.A.O.
BECAUSE IT'S A COMMON BUILDING THAT WOULD BE SHARED WITH THE
DEPARTMENT OF MENTAL HEALTH, SO WE WERE PROMPT TO MOVE ON
THIS, YOU KNOW, AS FAST AS WE COULD BECAUSE, YOU KNOW, NOT
MANY EXISTING OWNERS WANTED TO HAVE OUR OFFICE, YOU KNOW,
LOCATED IN THEIR FACILITY. SO THIS BECAME THE ONLY REALLY
OPTION THAT WE HAD AND SO THE LANDLORD WANTS TO DO THE
IMPROVEMENTS BOTH FOR THE DEPARTMENT OF MENTAL HEALTH AND US

AT THE SAME TIME. SO THIS HAS BEEN IN THE PLANNING FOR, I
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1 WOULD SAY, AT LEAST OVER 12, 18 MONTHS. AND, YOU KNOW, WE CAN

2 HOLD IT OVER BUT IT IS SOMETHING THAT WE DO NEED...

4 SUP. YAROSLAVSKY, CHAIRMAN: YEAH, I DON'T WANT TO HOLD IT OVER
5 FOR THE SAKE OF HOLDING IT OVER. IT'S JUST THAT, WHEN THIS

6 FIRST CAME UP, THE TENANT IMPROVEMENTS WERE BROUGHT TO OUR

7 ATTENTION BUT THE FURNITURE WASN'T AND, OBVIOUSLY, YOU'RE

8 GOING TO HAVE TO PUT FURNITURE IN A FACILITY BUT YOU HAVEN'T

9 GONE OUT TO BID ON THIS POINT. AT THIS POINT, IT'S JUST AN

10 ESTIMATE OF WHAT YOU THINK IT'S GOING TO COST.

11

12 CARLOS JACKSON: IT'S OUR INTERNAL ESTIMATE OF WHAT-- AND,

13 AGAIN, FOR THE FURNITURE, IT'S ONLY-- WE ESTIMATE 62,000 AT

14 MOST. THE REST IS FOR DEALING WITH THE COMPUTER WIRING AND

15 OTHER PARTS OF THE OPERATION. AND AT THE TIME THAT WE-- AT THE
16 TIME THAT WE BROUGHT THIS, WE DIDN'T HAVE THE OPPORTUNITY TO
17 DO THE ESTIMATES AND I DO APOLOGIZE TO THE BOARD THAT WE

18 DIDN'T MAKE A REFERENCE THAT WE WOULD BE COMING BACK WITH THIS
19 REQUEST.

20

21 SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. I'M NOT GOING TO ASK

22 THAT IT BE CONTINUED BUT I HOPE YOU'RE MINDFUL OF THE-- YOU

23 DON'T NEED TO BE LECTURED ABOUT IT BUT THE JUXTAPOSITION OF

24 THIS WITH THE OTHER ITEM COMING UP NEXT WEEK AND THE PROBLEMS

25 THAT WE'RE HAVING IN GETTING HOUSING VOUCHERS AND HOUSING
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1 BEING THE CRISIS THAT IT IS, THIS JUST DOESN'T GO DOWN WELL

2 WITH ME, ALTHOUGH I RECOGNIZE...

4 CARLOS JACKSON: WELL, THE TIMING WAS POOR.

6 SUP. YAROSLAVSKY, CHAIRMAN: WELL, IT'S NOT JUST THE TIMING. I

7 JUST HOPE THAT THESE ARE REASONABLE, YOU KNOW, FORD, NOT

8 CADILLACS, YOU KNOW, PRIUSES, NOT FORDS, YOU KNOW, IN THE WAY

9 OF FURNITURE.

10

11 CARLOS JACKSON: NO, AND WE AGREE WITH THAT. JUST THAT

12 SERVICING THE ANTELOPE VALLEY COMMUNITY FROM-- WITH THE

13 SATELLITE OFFICE IS VERY DIFFICULT TO START WITH AND THEN

14 WE'RE TRYING TO FIGURE OUT HOW TO USE TECHNOLOGY IN THE WAY TO
15 COMMUNICATE BETWEEN US BECAUSE, WHEN I HAVE STAFEF COME DOWN,

16 IT'S AN HOUR AND A HALF TO 2-HOUR DRIVE AND IT DOESN'T MAKE

17 SENSE FOR FOUR HOURS TO USE THEIR TIME JUST FOR, YOU KNOW,

18 MAYBE SOME TRAINING. SO THIS IS REALLY TO IMPROVE THAT AREA OF
19 OUR DELIVERY.

20

21 SUP. YAROSLAVSKY, CHAIRMAN: I UNDERSTAND. THANK YOU.

CARLOS JACKSON: OKAY. THANK YOU.
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SUP. YAROSLAVSKY, CHAIRMAN: DO YOU WANT TO MOVE IT? ANTONOVICH

MOVES, I'LL SECOND. WITHOUT OBJECTION, UNANIMOUS VOTE.

SUP. ANTONOVICH: NUMBER 68.

SUP. YAROSLAVSKY, CHAIRMAN: 68. WE HAVE TWO PEOPLE WHO WANT TO

BE HEARD ON THIS, DR.

IF YOU WANT TO ADDRESS THE OTHER ITEM, IT'S UP TO YOU. FOR

YOUR CONVENIENCE, WE'LL LET YOU DO THEM BOTH AT THE SAME TIME.

DR. GENEVIEVE CLAVREUL: GOOD MORNING, BOARD OF SUPERVISORS.
YOU KNOW, I'M NOT SURPRISED THAT YOUR EFFICIENCY COMMISSION
WILL NOT GET REASSESSED AT THE APPROPRIATE TIME. YOU KNOW, I
HAVE SURVEYED A LOT OF YOUR COMMISSIONS IN THE LAST, YOU KNOW,
7 YEARS AND THE MOST INEFFICIENT COMMISSION IS YOUR EFFICIENCY

COMMISSION. EVEN SO, THEY CONSTANTLY GET AWARDS. AND, YOU

KNOW, IT DOESN'T MAKE
COUNSEL WILL ALLOW IT
OF EFFICIENCY OF THAT
ARROGANT LAST WEEK TO
JOKE, THAT HE WILL GO
A TRULY DISRESPECT OF

ATTENTION. ITEM O9...

CLAVREUL AND ARNOLD SACHS. DR. CLAVREUL,

ANY SENSE. AND, ALSO, THAT YOUR COUNTY
TO EXPIRE IS ANOTHER PROOF OF THE LACK
OFFICE. AND FOR MR. FORTNER TO BE THAT
SAY, YOU KNOW, AS A JOKE, A FLIPPANT

TO A REMEDIAL CLASS IN THE BROWN ACT IS

YOUR OFFICE. THANK YOU FOR YOUR
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1 SUP. YAROSLAVSKY, CHAIRMAN: SURE, YOU WANT TO TALK ABOUT-- IS

2 IT 9 OR 7?2 WHICH ONE WAS IT?

4 DR. GENEVIEVE CLAVREUL: BOTH, BUT 9, I'M NOT GOING TO SPEAK TO
5 IT. AND, ON 7, I WOULD HAVE PREFERRED TO LISTEN TO THE

6 PRESENTATION FIRST, IF THAT'S OKAY WITH YOU.

8§ SUP. YAROSLAVSKY, CHAIRMAN: NO PROBLEM. MR. SACHS?

10 ARNOLD SACHS: GOOD MORNING, COUNTY BOARD OF SUPERVISORS. THANK
11 YOU VERY MUCH. BASICALLY, I WOULD ECHO THE PREVIOUS SPEAKER'S

12 COMMENTS AND JUST SAY HOW IRONIC THAT THE EFFICIENCY

13 COMMISSION ALLOWS ITS CHARTER TO EXPIRE AND HAS TO BE RESCUED.
14 IT SPEAKS VOLUMES FOR THE COMMISSIONS.

15

16 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. MR. SACHS, DID YOU WANT
17 TO ADDRESS ITEM 3 WHILE YOU'RE UP THERE?

18

19 ARNOLD SACHS: WHEN IT'S CALLED, SIR. THANK YOU.

20

21 SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. THEN DO ME A FAVOR AND

22 SIT CLOSER TO THE FRONT.

23

24 SUP. ANTONOVICH: I'LL MOVE 68 AND THEN CALL UP 3.

25
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1 SUP. YAROSLAVSKY, CHAIRMAN: COME ON UP, HE'S GOING TO DO 3

2 NEXT, MR. SACHS.

4 CLERK SACHI HAMAT: 68, CAN WE GET A MOTION?

6 SUP. YAROSLAVSKY, CHAIRMAN: NUMBER 68 IS MOVED BY BURKE,
7 SECONDED BY ANTONOVICH. WITHOUT OBJECTION, UNANIMOUS VOTE.

8 ITEM 3.

10 ARNOLD SACHS: IS THIS CLOSE ENOUGH?

11

12 SUP. YAROSLAVSKY, CHAIRMAN: VERY GOOD.

13

14 ARNOLD SACHS: THANK YOU. I JUST HAVE A GRAVE CONCERN ABOUT

15 THIS. LAST YEAR, COUNTY SUPERVISORS -- EXCUSE ME ONE SECOND.
16 THE COUNTY SUPERVISORS APPROVED THE ACTION IN MAY REGARDING

17 THE SUNSHINE COUNTY LANDFILL, WHERE IT INCREASED THE LANDFILL
18 AMOUNTS FROM 6,000 TO 12,000, FROM 12,000 TO 66,000 AND I

19 SPOKE ON THAT ITEM WHEN IT CAME BEFORE THE COUNTY SUPERVISORS.
20 MY CONCERNS REGARDED THE MATH, THE INTAKE BEING THE KEY PHRASE
21 IN THE INCREASE IN THE VOLUME OF THE SOLID WASTES. THIS ITEM

22 REFERS TO-- EXCUSE ME, REGULATIONS FROM THE CIWMB. SINCE THE

23 COUNTY BOARD OF SUPERVISORS NEGLECTS 6,600 TONS OF WASTE, WHAT
24  WILL HAPPEN IF THESE HAZARDS, THE BIOHAZARD WASTE MATERIALS

25 FALL UNDER THAT CATEGORY OF 6,600 TONS, SINCE THEY'RE
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1 NONEXISTENT BUT REAL? WILL THEY STILL FALL UNDER THE

2 REGULATIONS FOR THE CIWMB?

4 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. THANK YOU.

6 ARNOLD SACHS: THANK YOU.

8 SUP. YAROSLAVSKY, CHAIRMAN: ITEM 3 IS BEFORE US. MOVED BY

9 ANTONOVICH, SECONDED BY BURKE. WITHOUT OBJECTION, UNANIMOUS
10 VOTE.

11

12 SUP. ANTONOVICH: ITEM NUMBER 2.

13

14 SUP. YAROSLAVSKY, CHAIRMAN: ITEM 2. PETER BAXTER. GO AHEAD,

15 MR. BAXTER.

16

17 PETER BAXTER: THANK YOU, SIR. MR. CHAIRMAN, MEMBERS OF YOUR
18 HONORABLE BOARD, MS. HARPER, LADIES AND GENTLEMEN, MY NAME IS
19 PETER BAXTER AND I LIVE IN LOS ANGELES. IT IS RESPECTFULLY

20 SUBMITTED THAT THE CHIEF ADMINISTRATIVE OFFICER AND THE CHIEF
21 EXECUTIVE OFFICER ARE NOT NOTED ON THIS AGENDA. POSSIBLY THIS

22 IS TO AVOID CONFUSION IN THE CONCLUDING OFFICE WITH THE NEW

23 BEGINNING OFFICE ON THIS SAME DAY. AGENDA ITEM NUMBER 2 SPEAKS

24 TO OPERA FOR EDUCATORS. THIS PROGRAM IS TO BE PRESENTED OVER

25 THE NEXT FEW WEEKS BY THE LOS ANGELES OPERA. THIS PROGRAM
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1 REMINDS ME OF THE FORMER SUPERVISOR, THE HONORABLE EDMUND D.
2 EDELMAN, WHO HONORED ME BY SENDING A LETTER TO THE FIRE CHIEF,
3 MR. P. MICHAEL FREEMAN, ON MY BEHALF. AND, WITH YOUR

4 PERMISSION, MR. CHAIRMAN, I HOPE IT'S OKAY IF I READ PART OF

5 THIS LETTER FROM MR. EDELMAN. THE DATE OF THIS LETTER IS JULY
6 26TH, 1993. I JUST MENTION THAT THAT SEEMS TO BE ABOUT 8 YEARS
7 PRIOR TO 9/11 AND HE'S WRITING TO THE FIRE CHIEF AND HE SAYS,
8 "DEAR MIKE, AS YOU KNOW, MR. PETER BAXTER TAKES EVERY

9 OPPORTUNITY TO ADDRESS THE BOARD TO ADVOCATE THE USE OF TURBO
10 JET ENGINES FOR FIRE SUPPRESSION. I'M AWARE THAT YOU HAVE

11 PREVIOUSLY LOOKED INTO MR. BAXTER'S SUGGESTION. I AM ALSO

12 AWARE THAT YOU COMMUNICATED WITH PRATT AND WHITNEY AND

13 RECEIVED A LESS-THAN-ENTHUSIASTIC RESPONSE TO HIS SUGGESTION.
14 I BELIEVE IT WOULD BE PRUDENT..." NOW, THIS IS THE CHAIRMAN OF
15 THE BOARD OF SUPERVISORS OF THE COUNTY OF LOS ANGELES AND HE'S
16 SAYING, IN 1993, "I BELIEVE THAT IT WOULD BE PRUDENT FOR YOU
17 TO TAKE A SECOND LOOK AT MR. BAXTER'S SUGGESTION AND SEE IF

18 YOU CAN GENERATE ANY INTEREST AMONG MANUFACTURERS OF SMALL JET
19 ENGINES TO DEVELOP A RESEARCH PROGRAM TO EVALUATE THE USE OF
20 THEIR PRODUCT BY FIRE DEPARTMENTS. PERHAPS YOU COULD GAIN

21 SUPPORT FOR REQUESTING..." MY TIME IS RUNNING OUT BUT I THANK

22 YOU FOR LETTING ME...

23
24  SUP. YAROSLAVSKY, CHAIRMAN: YOU HAVE A HALF A MINUTE. GO

25  AHEAD.
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PETER BAXTER: FINISH IT?

SUP. YAROSLAVSKY, CHAIRMAN: YEAH, YOU HAVE HALF A MINUTE. YOUR

TIME ISN'T UP.

PETER BAXTER: OKAY. "PERHAPS YOU COULD GAIN SUPPORT FOR
REQUESTING A RESEARCH PROGRAM FROM YOUR COLLEAGUES IN THE
INTERNATIONAL ASSOCIATION OF FIRE CHIEFS AND/OR THROUGH THE
NATIONAL FIRE PROTECTION ASSOCIATION OR, AS SUGGESTED BY MR.
BAXTER, THE CENTER FOR FIRE RESEARCH. IN ANY CASE, I WOULD
APPRECIATE YOUR COOPERATION IN FINDING A WAY TO HAVE THIS IDEA
PROPERLY EVALUATED BY EXPERTS IN THE FIELD. THANK YOU.
SINCERELY EDMUND D. EDELMAN, CHAIRMAN BOARD OF SUPERVISORS."
WITH YOUR PERMISSION, I'D LIKE, MR. CHAIRMAN, TO OFFER A COPY
OF THE LETTER FOR EACH MEMBER OF THE BOARD AND MISS SACHI.

THANK YOU, SIR.

SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU, MR. BAXTER.

SUP. ANTONOVICH: MOVE THE ITEM.

SUP. YAROSLAVSKY, CHAIRMAN: MR. ANTONOVICH? ANTONOVICH MOVES,

MOLINA SECONDS. WITHOUT OBJECTION, UNANIMOUS VOTE.
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SUP. ANTONOVICH: ITEM NUMBER 7.

3 SUP. YAROSLAVSKY, CHAIRMAN: ITEM 77

5 SUP. ANTONOVICH: YEAH. MR. CHAIRMAN, ONE OF THE CONCERNS IS

6 THAT WE NEED ADDITIONAL INFORMATION BEFORE-- YOU KNOW, WE LOOK
7 BEFORE WE LEAP, A BETTER UNDERSTANDING OF ALL THE OPTIONS THAT
8§ ARE AVAILABLE. THERE HAVE BEEN SOME SERIOUS CRITICISMS OF THE
9 SAN FRANCISCO ORDINANCE WHICH ACTUALLY IS COUNTERPRODUCTIVE TO
10 RECYCLING EFFORTS. AND, ACCORDING TO TREX, WHICH IS A LARGE

11 MANUFACTURER OF NON-WOOD ALTERNATIVE DECKING AND RAILING

12 PRODUCTS, THE REQUIREMENT WOULD HAVE THE UNINTENDED

13 CONSEQUENCES OF MAKING IT VERY DIFFICULT TO RECYCLE

14 POLYETHYLENE. AND SO I'D JUST LIKE TO ADD AN AMENDMENT THAT WE
15 INCLUDE A REPORT BACK ANY IMPACTS OF THE PROPOSED ORDINANCE

16 WOULD HAVE ON THE LOS ANGELES COUNTY'S RECYCLING EFFORTS,

17  WHICH HAVE BEEN QUITE COMMENDABLE IN THE PAST, BEING ONE OF

18 THE FORERUNNERS IN THE BEGINNING OF GREEN WASTE RECYCLING AND-
19 - BEGINNING WITH THE CHRISTMAS TREE RECYCLING PROGRAM AND

20 OTHER EFFORTS THAT WE HAVE BEEN ABLE TO DO SUCCESSEFULLY. IN

21 FACT, I THINK WE HAVE A HIGHER RECYCLING RATE THAN OTHER

22 COUNTIES IN THE STATE OF CALIFORNIA. SO JUST ADD THAT, THE

23 IMPACTS THE PROPOSED ORDINANCE WOULD HAVE ON RECYCLING

24  EFFORTS.

25
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1 SUP. YAROSLAVSKY, CHAIRMAN: MS. BURKE?

3 SUP. BURKE: I HAVE NO OBJECTION TO THAT. I HAVE A REVISED

4 MOTION THAT I'D LIKE TO PASS OUT. AND, PRIMARILY, IT CLARIFIES
5 THE-- ACTUALLY WHAT WAS PASSED IN SAN FRANCISCO IN A LITTLE

6 BIT MORE TECHNICAL TERMS. AND WHAT THEY BECAME WAS THE FIRST

7 MUNICIPALITY TO JOIN A GLOBAL TREND TO BAN THE USE OF PLASTIC
8 BAGS IN GROCERY CHAINS AND RETAIL STORES IN FAVOR OF

9 COMPOSTABLE PLASTIC BAGS. AND THERE ARE A NUMBER OF THINGS

10 THAT I BELIEVE THAT WE HAVE TO LOOK AT. THERE'S NO QUESTION

11 THAT WE HAVE MORE PLASTIC BAGS GOING INTO OUR LANDFILLS AND

12 OUR OCEAN AND UP AND DOWN OUR STREETS THAN WE REALLY NEED. WE
13 NEED TO LOOK AT THIS ISSUE. NOW, HOW DOES IT SOLVE AND HOW DO
14 WE SOLVE IT? I'D LIKE TO FIRST BRING UP SOMEONE FROM PUBLIC

15 WORKS? MR. WILFRED, WOULD YOU COME FORWARD? MY MOTION REALLY
16 ASKS THAT THERE BE A STUDY OF THE ALTERNATIVES TO ALLOWING OUR
17 PRESENT POLICY OF OPENING, JUST OPEN USE OF PLASTIC BAGS. I

18 KNOW THAT RALPHS GIVES 5 CENTS IF YOU RETURN AND USE YOUR OWN
19 BAG. AND TRADER JOE'S DOES THAT. THEY ALLOW 5 CENTS ON YOUR

20 BILL IF YOU BRING YOUR OWN BAG. THESE ARE THE KIND OF THINGS
21 THAT I THINK ARE VERY POSITIVE THAT WE CAN LOOK AT AND THAT WE

22 CAN ENCOURAGE THROUGHOUT THE COUNTY, NOT ONLY WITH JUST THE

23 LARGE CHAINS BUT WITH OTHERS. BUT THERE'S SOME OTHER THINGS
24 THAT HAVE COME TO OUR ATTENTION. APPARENTLY, THAT THERE ARE

25 BAGS THAT ARE NOT NECESSARILY POLYETHYLENE-BASED. THERE ARE
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1 BAGS THAT ARE CORN STARCH-BASED THAT ARE BIODEGRADABLE.

2 SO, IN THIS DAY AND TIME, WE CAN'T JUST SAY OKAY, EVERYTHING'S
3 GREAT. WE NEED TO LOOK AT OTHER ALTERNATIVES. I KNOW THAT, IN
4 MY BLUE CAN, I LIVE IN THE CITY OF LOS ANGELES, SO, IN MY BLUE
5 CAN, IT SAYS "DON'T PUT PLASTIC BAGS." NOW, I CAN PUT PLASTIC
6 BOTTLES. I CAN PUT THINGS LIKE THAT BUT I CAN'T PUT PLASTIC

7 BAGS IN MY RECYCLABLES. SO THAT, OBVIOUSLY, THERE IS A REAL

8 CONCERN IN TERMS OF THE RECYCLING INDUSTRY AS IT RELATES TO

9 THOSE BAGS. WHAT I WOULD WANT TO SEE IS THAT WE LOOK AT

10 SOMETHING GOOD FOR LOS ANGELES. WE CAN'T FOLLOW SAN FRANCISCO,
11 BUT I DON'T THINK WE CAN BURY OUR HEADS IN THE SAND AND SAY

12 EVERYTHING'S GREAT AND WE DON'T WANT TO LOOK AT ANYTHING ELSE.
13 AND I WOULD LIKE TO GET SOME INPUT FROM THE DEPARTMENT ON

14 EXACTLY HOW THIS IS BEING TREATED IN TERMS OF PLASTICS GOING
15 INTO OUR-- THEY'RE GOING INTO OUR LANDFILLS MOSTLY, AREN'T

16 THEY?

17

18 DON WOLFE: YES, SUPERVISOR. DON WOLFE, DIRECTOR OF PUBLIC

19 WORKS. IT IS A VERY INTERESTING AND A VERY CHALLENGING PROBLEM
20 THAT WE HAVE. PLASTIC BAGS ARE A MAJOR SOURCE OF POLLUTION,

21 BASICALLY, WITH TRASH STREWN IN OUR PUBLIC WAYS AND ON PRIVATE

22 PROPERTY AND A VERY IMPORTANT ISSUE WITH RESPECT TO WATER

23 QUALITY IN LOS ANGELES COUNTY BECAUSE OF THE NUMBER OF THESE
24 BAGS THAT WIND UP IN THE RECEIVING WATERS. AND THEY'RE A BIG

25 FACTOR OF THE ISSUE OF DEALING WITH THE TRASH TMDL THAT THE
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1 REGIONAL BOARD HAS IMPOSED FOR BIONA CREEK AND THE L.A. RIVER.
2 MANY THINGS YOU SPOKE ABOUT, THE FACT THAT YOU CANNOT CO-

3 MINGLE WITH RESPECT TO RECYCLING THE BIODEGRADABLE BAGS AND

4 THE PLASTIC BAGS AND SEPARATING THEM ARE VERY DIFFICULT SO

5 THAT DOES CREATE A CHALLENGE TO RECYCLING WHAT'S LEFT OF THE
6 PLASTIC BAGS AND SOME OF THE ISSUES COULD BE TO COME UP WITH
7 PROGRAMS TO ENCOURAGE PEOPLE NOT TO USE THE PLASTIC BAGS AND
8 USE OTHER FORMS OF CONTAINERS AND A LOT OF OTHER AGENCIES DO
9 THAT. AND, ALSO, IN OTHER COUNTRIES I'VE NOTICED THAT THEY

10 HAVE ENCOURAGEMENTS THAT ARE VERY EFFECTIVE IN TURNING PEOPLE
11 AWAY FROM THE USE OF PLASTIC BAGS BUT NOT PROHIBITING THEIR
12 USE. SO WE WOULD LOOK AT THIS, IF THE BOARD PASSES THIS

13 MOTION, AS A REAL CHALLENGE TO LOOK AT ALL OF THE PLUSES AND
14 MINUSES AND COME BACK WITH A REPORT TO THE BOARD TO GIVE YOU
15 OPTIONS FOR A POLICY FOR L.A. COUNTY THAT WOULD WORK FOR THE
16 COUNTY AND NOT HAVE THOSE REPERCUSSIONS THAT UNFORESEEN

17 CONSEQUENCES THAT SUP. ANTONOVICH WAS TALKING ABOUT, SO THAT
18 WE GET A WIN/WIN ON BOTH THE RECYCLING ISSUE AND THE WASTE

19 REDUCTION ISSUE.

20

21 SUP. BURKE: WELL, OBVIOUSLY, WE HAVE TO WORK WITH THE GROCERS.

22 AND ALSO NOT JUST THE GROCERS, THE OTHER RETAILERS, YOU KNOW?

23 WE HAVE RETAILERS IN OUR DEPARTMENT STORES. EVERY ONE THAT AT
24 THIS POINT DEPEND UPON PLASTIC BAGS. AT THE SAME TIME, I KNOW

25 SOME OF US HAVE BEEN RELUCTANT TO USE PAPER BECAUSE WE THOUGHT
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1 THAT, IF WE WERE GOING TO USE PAPER, IT WAS A MATTER THAT WE
2 WERE GOING TO REALLY CAUSE TREES TO BE DESTROYED SO THAT THERE
3 WAS A RELUCTANCE AND SOME OF US WENT TO PLASTIC BECAUSE WE

4 THOUGHT THAT WAS THE MOST ADVISABLE. BUT, AT THIS POINT, WE

5 HAVE TO LOOK AT MAYBE SOME OTHER ALTERNATIVE, TO LOOK AT

6 METHODS OF WHERE WE CAN ENCOURAGE PEOPLE TO BRING THEIR OWN

7 BAGS, RETURN THEIR BAGS BUT TO DO SOMETHING THAT WE CAN MOVE

8 FORWARD. AND I HOPE THAT WE CAN LOOK VERY SERIOUSLY AT THESE

9 BIODEGRADABLE BAGS THAT ARE BASED ON-- WITH CORN STARCH AND

10 ENCOURAGE SOME OF THE COMPANIES TO LOOK AT THOSE IF, IN FACT,
11 THEY WORK. I DON'T KNOW WHETHER THEY WORK OR NOT. I DON'T KNOW
12 WHETHER THEY GO INTO THE LANDFILL AND THEY ARE DEGRADED THERE
13 OR NOT BUT I THINK THAT WE NEED TO LOOK AT THAT AND TO FIND

14  OUT.

15

16 DON WOLFE: WE WILL WORK WITH THE C.A.O0.'S OFFICE AND INTERNAL
17 SERVICES AND COME BACK WITH OPTIONS FOR YOUR BOARD AND THE

18 PLUSES AND MINUSES OF EACH ONE OF THE OPTIONS.

19

20 SUP. MOLINA: MR. CHATIRMAN?

21

22 SUP. YAROSLAVSKY, CHAIRMAN: MISS MOLINA?

23
24 SUP. MOLINA: YOU KNOW, I THINK COSTCO IS THE ONE THAT'S GOT IT

25 RIGHT. THEY JUST GIVE YOU BOXES AT THE END OF THE COUNTER AND
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1 YOU JUST PACK UP ALL YOUR STUFEF IN THE RECYCLED BOXES. THEY DO
2 IT ALL THERE. ANYWAY, IT MAKES A HECK OF A LOT OF SENSE. BUT

3 LET ME ASK A QUESTION ABOUT JURISDICTION. I DON'T KNOW IF OUR
4 LAWYER NEEDS TO ANSWER THIS AS WELL. IF WE WERE TO IMPOSE

5 SOMETHING LIKE THIS, DOES THIS ONLY FUNCTION AND OPERATE IN

6 OUR COUNTY UNINCORPORATED AREAS THAT WE PULL TRASH IN WHERE WE
7 HAVE JURISDICTION OVER GROCERY STORES OR COULD THIS BE A

8 COUNTYWIDE ISSUE BECAUSE WE ALSO HAVE, I MEAN, THE LANDFILL IS
9 IN OUR AREA? WE ARE TAKING IN MOST OF THE TRASH FROM THOSE

10 AREAS. SO, JURISDICTIONALLY, COULD WE HAVE A LARGER IMPACT

11 THAN JUST THE UNINCORPORATED GROCERY STORES?

12

13 RAYMOND G. FORTNER, JR., COUNSEL: MR. CHAIRMAN, MEMBERS OF THE
14 BOARD, THIS IS A QUESTION WE HAVE BEEN LOOKING AT AND THE

15 ANSWER IS NOT ABSOLUTELY CLEAR YET BUT I BELIEVE THAT, WHILE
16 THE COUNTY'S POLICE POWER DOES EXTEND JUST TO THE

17 UNINCORPORATED AREA OF THE COUNTY, IT IS A PRINCIPLE THAT YOUR
18 BOARD IS VERY FAMILIAR WITH, THERE ARE A NUMBER OF AREAS, AS
19 YOU POINT OUT, INVOLVING TRASH AND RECYCLING ACTIVITIES THAT
20 EXTEND INTO INCORPORATED AREAS OR EVEN BEYOND THE BOUNDARIES
21 OF THE COUNTY. AND I BELIEVE THAT IT MAY WELL BE POSSIBLE

22 BECAUSE OF THE IMPACT HERE, THAT THERE COULD BE SOME

23 REGULATIONS THAT WOULD APPLY ON A COUNTYWIDE BASIS RATHER THAN
24 LIMITED MERELY TO ACTIVITIES THAT OCCUR WITHIN THE

25 UNINCORPORATED AREA. BUT, AS I SAY, MY STAFF IS COMPLETING A
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1 REPORT ON THAT AND WE HOPE TO HAVE THAT VERY QUICKLY TO RETURN

2 WITH THE ALTERNATIVES.

4 SUP. MOLINA: SO THAT WILL BE PART OF THE ANALYSIS IS OUR

5 JURISDICTIONAL CAPABILITY?

7 RAYMOND G. FORTNER, JR.: YES, THAT'S CORRECT.

9 SUP. BURKE: ONE THING IS I THINK THE CITY OF LOS ANGELES HAS
10 INDICATED THEY WOULD WORK WITH US. THEY CONSIDERED THIS AND I
11  THINK THEY WENT TO A RECYCLING SYSTEM. I DON'T KNOW HOW IT

12 WORKS BECAUSE I HAVE NOT REALLY RECEIVED THE INFORMATION AS A
13 CITY RESIDENT EXACTLY HOW YOU RECYCLE THE PLASTIC BAGS.

14

15 SUP. MOLINA: MISS BURKE, I WAS GOING TO RECOMMEND, AND I DON'T
16 KNOW HOW YOU FEEL ABOUT IT, THAT ONE OF THE THINGS YOU MIGHT
17  LOOK AT AS WELL, IS MAYBE TAKING A LEADERSHIP ROLE WITHIN THE
18 COUNTY AND TRYING TO ENCOURAGE THE CITIES TO JOIN WITH US. AND
19 IF WE WERE ALL COLLECTIVELY TOGETHER, THIS IS AN AWFULLY LARGE
20 COUNTY OF 10 MILLION RESIDENTS THAT HAVE UNBELIEVABLE PROBLEMS
21 WHEN IT COMES TO LANDFILLS AND LOOKING AT OPTIONS THAT MIGHT

22 BE AVAILABLE TO US. I THINK INSTEAD OF EVERY CITY MAYBE DOING

23 IT BUT LOOKING AT ALL THE CITIES AND THEN SEEING IF WE CAN
24 COME UP WITH A COMBINED SOLUTION SO THAT IT WORKS FOR THE

25 CITIES, AS WELL. THERE MIGHT BE DIFFERENT APPROACHES THAT WE
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MIGHT USE AND IT MIGHT ADDRESS SOME OF THE ISSUES ABOUT-- THAT
MR. ANTONOVICH IS RAISING, AS WELL. BUT I JUST THINK IT WOULD
BE-- TO DO IT IN ISOLATION IS ONLY LIKE ONE PART OF THE
SOLUTION. IF WE COULD PROVIDE A LEADERSHIP ROLE AND MAYBE LOOK
AT THE OTHERS, I'M SURE THAT MANY OF THE OTHER CITIES WOULD
ALSO WANT TO DO SOMETHING LIKE THIS. BUT THE SOLUTION HAS TO
BE-- IT COULD BE INCENTIVES BUT IT'S PROBABLY ENCOURAGING THE
GROCERY STORES TO LOOK AT HOW THEY THEMSELVES CAN TAKE IT ON.
LIKE I SAID, COSTCO DOES IT ALL BY ITSELF. MOST OF US ARE
PACKING OUR OWN GROCERIES NOWADAYS. THEY DON'T HAVE PACKERS
ANY MORE LIKE THEY USED TO IN MOST PLACES. AT LEAST, THE
GROCERY STORES THAT I SHOP IN. WE ALL GO TO THE EDGE AND START
PACKING OUR OWN STUFE INTO PLASTIC BAGS. BUT IF THEY PROVIDED,
YOU KNOW, OTHER BAGS, PAPER OR IF THEY PROVIDED BOXES, WE
COULD DO THAT, AS WELL. SO I'M JUST TRYING TO THINK THE
SOLUTION MIGHT BE MORE COUNTYWIDE AND WE MIGHT WANT TO INVITE
SOME OF THE CITIES TO JOIN WITH US IN LOOKING AT WHAT KIND OF
ORDINANCE, WHAT KIND OF RULE MAKING OR WHAT KIND OF INCENTIVES
WE WOULD CREATE IN ORDER TO GET RID OF THE PLASTIC BAGS IN OUR

LANDFILLS.

SUP. BURKE: I REALLY AGREE WITH THAT. I THINK WE DO HAVE TO
WORK WITH THE CITIES. SOME CITIES, OF COURSE, ON THEIR OWN,

MALTIBU HAS TAKEN ACTION. SO WE NEED TO WORK WITH THEM. AND I
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1 THINK THAT, IF WE COME UP WITH SOMETHING, WE'LL BE ABLE TO

2 WORK BETTER WITH THE CITIES IN DOING THAT.

4 SUP. MOLINA: SO WE MIGHT WANT TO ENCOURAGE YOU TO REALLY LOOK
5 AT A WAY THAT YOU MIGHT BRING IN THE CITIES INTO THIS

6 DISCUSSION AND SEE WHAT KIND-- SOME WHO HAVE ALREADY DONE IT,
7 HOW THEY DO IT AND WHAT THEY'RE DOING. BUT ALSO-- BECAUSE I

8 KNOW THAT, IN SOME OF THE UNINCORPORATED AREAS, WE HAVE SOME
9 MARKETS BUT MOST OF OUR CHAINS ARE OUTSIDE OF MANY OF THE

10 UNINCORPORATED AREAS.

11

12 DON WOLFE: WE WILL DO THAT, SUPERVISOR, BECAUSE YOU'RE

13 CORRECT. UNLESS WE'RE ALL IN IT TOGETHER IN DOING THE SAME

14 THING OR SIMILAR THINGS, WE'RE NOT GOING TO HAVE A BIG IMPACT.
15

16 SUP. BURKE: ALL RIGHT, I'LL MOVE IT AS AMENDED.

17

18 SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. IT'S MOVED AS AMENDED,
19 I'LL SECOND IT. AND WITHOUT OBJECTION? UNANIMOUS VOTE.

20

21 CLERK SACHI HAMAI: AND THAT ALSO INCLUDES SUPERVISOR

ANTONOVICH'S...?
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1 SUP. YAROSLAVSKY, CHAIRMAN: YES, IT DOES. SUP. ANTONOVICH'S
2  AMENDMENT WAS AGREED TO. ALL RIGHT. MIKE, DO YOU HAVE ANY

3 OTHERS?

5 SUP. ANTONOVICH: THAT'S IT. THANK YOU.

7 SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. SUPERVISOR MOLINA, DO

8 YOU HAVE ANY ADJOURNING MOTIONS?

10 SUP. MOLINA: YES, I DO. I HAVE TWO OF THEM.

11

12 SUP. YAROSLAVSKY, CHAIRMAN: YOU'RE UP. OH, I'M SORRY. HANG ON,
13 HANG ON. DR. CLAVREUL, YOU WANTED TO SPEAK? WELL, DO YOU WANT
14 TO SPEAK ON IT? WE'LL RECONSIDER IT. NO, IT'S NOT TOO LATE. IF
15 YOU'D LIKE TO SPEAK, WE'LL RECONSIDER IT. OKAY, ALL RIGHT. T
16 APOLOGIZE. THERE WERE THREE PEOPLE WHO WANTED TO BE HEARD. I'M
17 GOING TO ASK THAT WE...

18

19 SUP. BURKE: ALL RIGHT. I'LL MOVE TO RECONSIDER.

20

21 SUP. YAROSLAVSKY, CHAIRMAN: MOVE TO RECONSIDER. I'LL SECOND

22 IT. WITHOUT OBJECTION, IT'S BACK BEFORE US. WE HAVE ALL THE

23  AMENDMENTS BEFORE US. EVERYBODY NOW HAS THE BENEFIT OF THE
24 DISCUSSION OF THE BOARD. JENNIFER, IS IT FORKISH? AND EVELYNE

25 MICHAUT? I WANT TO KNOW HOW CLOSE I CAME TO THE PRONUNCIATION
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1 ON THAT ONE. I EITHER HIT THE JACKPOT OR I BUTCHERED BOTH OF

2 YOUR NAMES.

4 JENNIFER FORKISH: NO, YOU GOT FORKISH RIGHT.

6 SUP. YAROSLAVSKY, CHAIRMAN: FORKISH I GOT RIGHT. HOW ABOUT IS

7 IT EVELYNE?

9 EVELYNE MICHAUT: EVELYNE MICHAUT.

10

11 SUP. YAROSLAVSKY, CHAIRMAN: EVELYNE MICHAUT?

12

13 EVELYNE MICHAUT: THAT'S RIGHT.

14

15 SUP. YAROSLAVSKY, CHAIRMAN: I WAS HALF RIGHT. ALL AHEAD, MISS
16 FORKISH.

17

18 JENNIFER FORKISH: ALL RIGHT, GOOD MORNING, MEMBERS OF THE
19 BOARD, MY NAME IS JENNIFER FORKISH AND I AM THE DIRECTOR OF
20 LOCAL GOVERNMENT RELATIONS FOR THE THE CALIFORNIA GROCERS
21 ASSOCIATION, A STATEWIDE TRADE ASSOCIATION REPRESENTING

22 APPROXIMATELY 500 RETAIL MEMBERS OPERATING OVER 6,000 STORES

23 IN CALIFORNIA AND NEVADA AND APPROXIMATELY 300 GROCERY
24 SUPPLIER COMPANIES. ON BEHALF OF THE CALIFORNIA GROCERS'

25 ASSOCIATION, I WANT TO EXPRESS A GENERAL CONCERN WITH THE
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1 MOTION BEING PUT FORWARD THIS MORNING. FIRST, CGA REQUESTS
2 THAT TWO FACTUAL INACCURACIES IN THE MOTION BE CORRECTED. THE
3 SECOND PARAGRAPH OF THE MOTION STATES, "IN OUR COMMUNITY, THE
4 PREVALENCE OF PLASTIC GROCERY BAGS, ESPECIALLY ONES MADE OF

5 PETROLEUM-BASED POLYETHYLENE, HAVE A LONG TRACK RECORD OF

6 ENVIRONMENTAL DEGRADATION." THIS STATEMENT IS MISLEADING.

7 GROCERY RETAILERS ARE NOT THE SOLE DISTRIBUTORS OF PLASTIC

8 BAGS, AS YOU'VE ALREADY DISCUSSED THIS MORNING. A WIDE VARIETY
9 OF RETAILERS UTILIZE PLASTIC BAGS. WE THEREFORE ASK THAT THE
10 STATEMENT BE AMENDED TO READ "PLASTIC CARRYOUT BAGS", A TERM
11 THAT HAS BEEN USED IN PRECEDING LEGISLATION AND THAT FURTHER
12 REFERENCES BE AMENDED AS SUCH. THE FIFTH PARAGRAPH OF THE

13 MOTION READS "SAN FRANCISCO RECENTLY BECAME THE FIRST

14 MUNICIPALITY IN THE NATION TO JOIN A GLOBAL TREND TO BAN THE
15 USE OF NON-RECYCLABLE PLASTIC BAGS IN GROCERY CHAINS AND

16 RETAIL STORES."™ IN FACT, SAN FRANCISCO BANNED THE USE OF ALL
17 RECYCLABLE PLASTIC BAGS. IT IS IMPORTANT TO NOTE THAT THE SAN
18 FRANCISCO ORDINANCE MANDATES CERTAIN RETAILERS WHO USE PLASTIC
19 BAGS TO NOW USE PLASTIC BAGS THAT ARE COMPOSTABLE. AND THAT'S
20 SORT OF A TECHNICAL ISSUE WITH THAT. SO WE REQUEST THAT THIS
21 PORTION OF THE MOTION BE AMENDED SO THAT IT ACCURATELY

22 REFLECTS. ..

23

24 SUP. BURKE: WE HAVE DONE THAT.

25
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1 JENNIFER FORKISH: OKAY, GREAT. WHILE WE SUPPORT YOUR

2 WILLINGNESS TO INCLUDE OUR INDUSTRY IN AN ONGOING STUDY, FOR

3 TWO REASONS CGA BELIEVES THAT SUCH AN EVALUATION MAY BE

4 PREMATURE AT THIS TIME. FIRST, THE IMPACTS OF THE ORDINANCE

5 PASSED BY THE CITY OF SAN FRANCISCO ARE NOWHERE CLOSE TO BE

6 READY FOR EVALUATION, ESPECIALLY IN THE 90 DAYS CALLED FOR IN
7 YOUR MOTION. WHILE IT CAN BE EVALUATED SUPERFICIALLY, THE

8 IMPACTS ON THE ENVIRONMENT AND CONSUMERS, AS WELL AS THE TRUE
9 AND REAL IMPACTS ON INDUSTRY, ARE INCAPABLE OF BEING MEASURED
10 IN 90 DAYS. SECOND: ASSEMBLY BILL 2449 STATUES OF 2006

11 ESTABLISH A STATEWIDE RECYCLING PROGRAM FOR PLASTIC BAGS. AB-
12 2449 MANDATES THAT GROCERY RETAILERS WITH GROSS ANNUAL SALES
13 OF $2 MILLION AND STORES OF 10,000 SQUARE FEET OR MORE WITH A
14 LICENSED PHARMACY PROVIDE A COLLECTION POINT FOR PLASTIC BAGS,
15 RECYCLE THE MATERIALS RETURNED BY CONSUMERS AND PROVIDE

16 REUSABLE CARRYOUT BAGS FOR CONSUMER PURCHASE BY JULY 1ST OF

17 2007. THEREFORE, THIS PROGRAM WILL NOT BE IN EFFECT DURING THE
18 TIME FRAME PRESENTED IN YOUR MOTION. THIS BILL GAINED REGIONAL
19 SUPPORT FROM SUCH LOCAL ENTITIES AS THE LOS ANGELES COUNTY

20 SOLID WASTE MANAGEMENT COMMITTEE, INTEGRATED WASTE MANAGEMENT
21 TASKFORCE WHO STRONGLY BELIEVES THAT AB-2449 WILL FURTHER

22 RECYCLING OF PLASTIC BAGS IN OUR COMMUNITY. WE STRONGLY

23 BELIEVE THAT THE SUCCESS OF THE NEW STATE PROGRAM HAS YET TO
24 BE SEEN SINCE THE IMPLEMENTATION DATE IS STILL THREE MONTHS

25 AWAY. MANY LOCAL RETAILERS, BOTH GROCERY AND NON-GROCERY, ARE
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1 CURRENTLY ESTABLISHING THE INFRASTRUCTURE TO COMPLY WITH THE
2 STATE LAW. GIVEN THAT THE IMPACTS OF THE SAN FRANCISCO PROGRAM
3 HAVE YET TO BE SEEN, AS WELL AS THE FACT THAT A STATEWIDE

4 RECYCLING PROGRAM FOCUSED SOLELY ON PLASTIC BAGS IS LESS THAN
5 THREE MONTHS FROM INITIATION, CGA ASKED THAT MEMBERS OF THE

6 LOS ANGELES COUNTY BOARD OF SUPERVISORS DELAY A STUDY AT THIS

7 TIME. THANK YOU.

9 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. MISS MICHAUT? AND DR.
10 CLAVREUL? YOU'LL PASS? OKAY. GO AHEAD.

11

12 EVELYNE MICHAUT: MY NAME IS EVELYNE MICHAUT. I'M HERE TO

13 REPRESENT NRDC, THE NATURAL RESOURCES DEFENSE COUNCIL. NRDC IS
14 A NATIONAL NONPROFIT ENVIRONMENTAL ORGANIZATION. WE HAVE

15 MEMBERS THROUGHOUT THE U.S. WE HAVE ABOUT 30, A LITTLE MORE
16 THAN 30,000 MEMBERS IN THE COUNTY OF LOS ANGELES. SO I'M HERE
17 THIS MORNING TO SUPPORT THE COUNTY'S EFFORT TO ADDRESS THE

18 ENVIRONMENTAL ISSUES THAT ARE CAUSED BY PLASTIC BAGS EFROM

19 GROCERS OR, AS YOU POINTED OUT, ANY RETAILERS, ACTUALLY. I

20 THINK WE'RE ALL AWARE OF THESE ISSUES. A FEASIBILITY STUDY IS
21 A REALLY IMPORTANT AND NECESSARY STEP AND I WOULD LIKE TO

22 OFFER NRDC SUPPORT IN EXPLORING ALTERNATIVES FOR CARRY BAGS.

23 ONE COMMENT I'D LIKE TO MAKE IS THIS STUDY, I THINK, NEEDS TO
24 TAKE A SERIOUS LOOK AT THE EXISTING WASTE COLLECTION

25 INFRASTRUCTURE. THE REASON WHY THIS WAS DOABLE IN SAN
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1 FRANCISCO, AND WE'LL SEE THE RESULTS, BUT THEY HAVE AN

2 EXISTING FOOD WASTE COLLECTION AND A CITYWIDE COMPOSTING

3 SYSTEM THAT I'M NOT SURE EXISTS PROPERLY IN L.A., IN THE

4 COUNTY. SO IS THE GREEN WASTE COLLECTION HERE EFFECTIVE AND

5 COULD IT BE EXPANDED TO FOOD WASTE? IF IT IS EXPANDED TO FOOD
6 WASTE, WOULD THE COMPOSTING SYSTEM BE ABLE TO PROCESS THE BIO
7 BAGS? I'M TALKING, OF COURSE, IF WE'RE LOOKING AT BANNING

8 RECYCLABLE PLASTIC BAGS, PETRO PLASTICS AND INSTEAD GOING TO

9 BIO-BASED PLASTICS. SO THESE ARE DESIGNED, THIS IS PRETTY

10 TECHNICAL, THEY ARE DESIGNED TO COMPOST ONLY IN COMMERCIAL

11 COMPOSTING SYSTEMS. THEY ARE NOT GOING TO DECOMPOSE IN A

12 LANDFILL. THERE'S ANOTHER ISSUE ABOUT FINDING THOSE BIO-BASED
13 PLASTICS IF WE'RE REALLY TRYING TO MAKE ENVIRONMENTAL PROGRESS
14 HERE, BIO-BASED PLASTICS ARE WHERE THEY'RE COMING FROM. THEY
15 ARE COMING FROM DEDICATED CROPS, IN WHICH CASE, YOU'RE SETTING
16 AGRICULTURAL LAND ASIDE FROM FOOD PRODUCTION TO MAKE PLASTIC
17 BAGS. IT'S PRETTY RESOURCE-INTENSIVE. IS THAT WORTH IT? SO WE
18 DEFINITELY NEED TO LOOK AT A LOT OF ALTERNATIVES FOR CARRY

19 BAGS. SO MAYBE SOME RECYCLABLE PLASTIC BAGS AND HAVE A REALLY
20 STRONG EFFORT TO RECYCLE ALL THESE PLASTIC BAGS. I THINK THAT
21 WOULD ENTAIL A LOT OF EDUCATION THROUGH PUBLIC EDUCATION AND

22 RETAILERS' EDUCATION AND THEN ENCOURAGING CANVAS BAGS,

23 REUSABLE BAGS. SO DIFFERENT OPTIONS THAT, YOU KNOW, EITHER
24 CHARGING FOR THE USE OF PLASTIC BAGS OR GIVING BACK MONEY, AS

25 SOME RETAILERS ALREADY DO.
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SUP. YAROSLAVSKY, CHAIRMAN: OKAY, THANK YOU.

SUP. BURKE: THANK YOU VERY MUCH. OH, RIGHT. IT SAYS AND

RETAIL. IT DOESN'T SAY JUST GROCERY. IT SAYS AND OTHER RETATL.

SUP. YAROSLAVSKY, CHAIRMAN: MS. MICHAUT AND DR. CLAVREUL COULD
HAVE A CONVERSATION IN FRENCH OR YOU'D LIKE TO TESTIFY IN

FRENCH. ..

SUP. BURKE: I'LL MOVE IT.

SUP. YAROSLAVSKY, CHAIRMAN: IT'S MOVED AND SECONDED. WITHOUT
OBJECTION, UNANIMOUS VOTE AS AMENDED. IT WOULD ADD A LITTLE
CLASS TO THE JOINT, WOULDN'T IT? LET'S FACE IT. IF WE-- OUI.
OKAY. NEXT ITEM, MR. ANTONOVICH IS THROUGH. SO, MISS MOLINA,

YOU'RE UP WITH YOUR ADJOURNING MOTIONS.

SUP. MOLINA: THIS MORNING, I'D LIKE TO ASK THAT WE ADJOURN IN
MEMORY OF ARMY MEDIC GABRIEL FIGUEROA OF BALDWIN PARK WHO WAS
KILLED WHILE SERVING OUR COUNTRY IN IRAQ. GABRIEL WAS ASSIGNED
TO THE FIRST BATTALION OF THE EIGHTH CAVALRY REGIMENT, THE
SECOND BRIGADE COMBAT TEAM AND THE FIRST CAVALRY DIVISION EFROM
FORT HOOD, TEXAS. WE WANT TO PAY TRIBUTE TO HIS PROFOUND

SERVICE TO OUR COUNTRY AND WE WANT TO EXTEND OUR HEARTFELT
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1 CONDOLENCES TO HIS FAMILY, TO HIS FRIENDS AND TO CERTAINLY ALL

2 OF HIS FELLOW SOLDIERS.

4  SUP. YAROSLAVSKY, CHAIRMAN: UNANIMOUS VOTE.

6 SUP. MOLINA: THANK YOU. I ALSO ASK THAT WE ADJOURN IN MEMORY

7 OF CHARLIE BRIAN GARCIA, THE BELOVED NEPHEW OF MY LONG TIME

8 STAFE MEMBER, BERTHA SANDOVAL. WE WANT TO EXTEND OUR THOUGHTS

9 AND PRAYERS AND OUR DEEPEST CONDOLENCES TO BERTHA AND HER

10 ENTIRE FAMILY. UNANIMOUS VOTE.

11

12 SUP. MOLINA: THANK YOU. THAT'S ALL THAT I HAVE. OKAY.

13

14 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. MS. BURKE?

15

16 SUP. BURKE: I HAVE SOME ADJOURNING MOTIONS. I MOVE THAT, WHEN
17 WE ADJOURN TODAY, WE ADJOURN IN MEMORY OF JACK NOVAK, THE

18 FATHER-IN-LAW OF LINDA NOVAK, OWNER OF HAL'S RESTAURANT IN

19 VENICE WHO PASSED AWAY RECENTLY AT THE AGE OF 95. HE LEAVES TO
20 CHERISH HIS MEMORY HIS SON, DONALD NOVAK, AND WIFE, LINDA, AND
21 TWO GRANDCHILDREN, KIKO AND SCOTT. AND ANTHONY MINNARD, A

22 LONG-TIME SECOND DISTRICT RESIDENT AND LOS ANGELES COUNTY

23 PARKS AND RECREATION GROUND MAINTENANCE WORKER AT ALONDRA PARK
24 WHO PASSED AWAY ON MARCH 30TH AFTER A BATTLE WITH THROAT

25 CANCER. HE LEAVES TO CHERISH HIS MEMORY HIS WIFE, JULIE
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1 CASTILLO MINNARD, MOTHER, MYRTLE MINNARD, AND BROTHER, WARREN
2 CHARLES. AND ERIC B. THOMAS, WHO WAS A VERY ACTIVE PERSON IN

3 PHI BETA SIGMA FRATERNITY AND OF THE MOST WORSHIPFUL SONS OF

4 LIGHT GRAND LODGE INSPECTOR GENERAL THE THIRD, 33-DEGREE MASON
5 WHO PASSED AWAY YESTERDAY, APRIL 9TH OF A MASSIVE HEART

6 ATTACK. ERIC THOMAS WAS-- GRADUATED FROM UCLA AND WAS A

7 CHARTER MEMBER OF KAPPA DELTA SIGMA CHAPTER, THE SOUTHERN

8 CALIFORNIA ALUMNI AND WAS VERY ACTIVE IN LOS ANGELES IN

9 NUMEROUS ACTIVITIES.

10

11 SUP. YAROSLAVSKY, CHAIRMAN: UNANIMOUS VOTE.

12

13 SUP. BURKE: I'LL CALL ITEM 9. DID ANYONE CALL THAT UP?

14

15 SUP. YAROSLAVSKY, CHAIRMAN: I THINK WE DID IT.

16

17 CLERK SACHI HAMAI: NO, WE DID NOT. THE INDIVIDUAL, THE MEMBER

18 OF THE PUBLIC WITHDREW HER REQUEST TO SPEAK ON IT, SO WE JUST

19 NEED TO...

20

21 SUP. YAROSLAVSKY, CHAIRMAN: HAVE A MOTION.

SUP. BURKE: I'LL MOVE IT.
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1 SUP. YAROSLAVSKY, CHAIRMAN: BURKE MOVES, MOLINA SECONDS.

2 UNANIMOUS VOTE.

4 SUP. BURKE: I DON'T THINK THERE'S ANYTHING ELSE.

6 CLERK SACHI HAMAI: ITEM 30.

8§ SUP. YAROSLAVSKY, CHAIRMAN: ITEM 30.

10 SUP. BURKE: OKAY, YOU WERE HOLDING THAT.

11

12 SUP. YAROSLAVSKY, CHAIRMAN: YEAH. WHO IS SPEAKING FOR THE

13 STAFF ON THIS? COULD WE GET THEM OUT HERE? WHILE THEY'RE DOING
14 THAT, LET ME DO MY ADJOURNMENT MOTIONS. WHILE THEY'RE COMING
15 Up, LET ME JUST-- I ASK THAT WE ADJOURN IN THE MEMORY OF GRAND
16 RABBTI ELIEZER ADLER, WHO PASSED AWAY IN LATE FEBRUARY. A

17 FAMILIAR AND REVERED FIGURE IN THE JEWISH COMMUNITY, LONG

18 AFFILIATED WITH CONGREGATION OHEL DAVID OF THE FAIRFAX AREA,

19 LONG TIME FRIEND OF MY PARENTS AND MYSELFEF. ONE OF MY EARLIEST
20 MEMORIES IS GOING TO HIS SYNAGOGUE DURING SOME OF THE

21 FESTIVALS. RECENTLY PASSED AWAY AFTER A LONG AND DIFFICULT

22 ILLNESS. HE WAS BORN IN JERUSALEM WHEN IT WAS STILL UNDER

23 OTTOMAN CONTROL AND LIVED ALMOST A CENTURY AND WAS BURIED IN
24 JERUSALEM JUST A FEW WEEKS AGO. HE IS SURVIVED BY HIS

25 DAUGHTER, MIRIAM HUTTLER, AND SON-IN-LAW RABBI RUBIN HUTTLER
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1 AND MANY OTHER FAMILY MEMBERS AND FRIENDS. ROBERT "ROBBIE"
2 KINZLE, A LONG-TIME RESIDENT OF THE SAN FERNANDO VALLEY WHO

3 RECENTLY PASSED AWAY AT THE AGE OF 44. HE WAS ACTIVE IN THE

4 ROSEDA NEIGHBORHOOD WATCH AS A BLOCK CAPTAIN. VOLUNTEERED HIS
5 TIME EVERY YEAR FOR OFFICER APPRECIATION DAY. HE WAS LOVED BY
6 MANY AND WILL BE GREATLY MISSED BY HIS FAMILY AND FRIENDS.

7 HE'S SURVIVED BY HIS MOTHER, ANN, WHO IS THE EXECUTIVE

8 DIRECTOR OF THE ROSEDA CHAMBER OF COMMERCE, HIS SISTER,

9 MICHELLE, AND TWO BROTHERS, WILLIAM AND MARK. I ALSO ASK THAT
10 WE ADJOURN IN MEMORY OF PEARL SLOAN. RESIDENT OF TOPANGA WHO
11 RECENTLY PASSED AWAY AT THE AGE OF 89. CAME TO TOPANGA IN

12 1948, WHERE SHE AND HER HUSBAND BUILT THEIR HOUSE AROUND AN
13 OAK TREE. IN IT, THEY RAISED FIVE CHILDREN TOGETHER. SHE WAS
14 TIRELESSLY ACTIVE IN THE COMMUNITY FOR MANY YEARS, WITH THE
15 PTA, THE TOPANGA WOMEN'S CLUB, THE GIRL SCOUTS, TOPANGA

16 RESOURCE CONSERVATION DISTRICT, TOPANGA HISTORICAL SOCIETY AND
17 OTHER THINGS. HER TRUE HOBBY, THOUGH, WAS PEOPLE AND THE

18 PEOPLE SHE TOUCHED SPANNED MANY GENERATIONS. SHE IS SURVIVED
19 BY HER HUSBAND OF 68 YEARS, BILL SLOAN, THREE SONS, BILL,

20 DAVID AND JOHN, TWO DAUGHTERS, MARIAN AND BARBIE AND 13

21 GRANDCHILDREN AND SIX GREAT- GRANDCHILDREN. LAST, AS WE

22 ADJOURN IN MEMORY OF NELLY ROSENFELD, WHO PASSED AWAY AT THE

23 AGE OF 97, A MUCH BELOVED FIGURE AND ACTIVE VOLUNTEER IN HER
24 SYNAGOGUE COMMUNITY OF TEMPLE ISRAEL IN HOLLYWOOD, WHERE SHE

25 WORKED HARD TO ORGANIZE THE TEMPLE SABBATH RECEPTIONS FOR THE
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1 PAST 18 YEARS, NEVER MISSING A SINGLE WEEK. SHE HAS AN

2 EXTRAORDINARY PERSONAL STORY. BORN IN CZECHOSLOVAKIA, LATER

3  RESIDING IN PARIS, SHE FLED TO THE FRENCH COUNTRYSIDE WITH HER
4 HUSBAND AND DAUGHTER DURING THE NAZI OCCUPATION AND WAS

5 SHELTERED FROM 1943 TO '45, WHEN FRANCE WAS FINALLY LIBERATED.
6 SHE WAS A INSTITUTION IN OUR COMMUNITY AND IN OUR DISTRICT.

7 AND SHE IS SURVIVED BY HER GRANDCHILDREN, BEN SCHICK AND SASA

8 BLACKOFF AND A GREAT GRANDSON, JACOB. THOSE ARE MY ADJOURNING

9 MOTIONS. UNANIMOUS VOTE. ON ITEM 30, COULD YOU IDENTIFY

10 YOURSELVES JUST FOR THE RECORD?

11

12 JACOB WILLIAMS: JACOB WILLIAMS, ASSISTANT DIRECTOR FOR PUBLIC

13 WORKS DEPARTMENT.

14

15 DAVID HOWARD: I'M DAVID HOWARD, I'M THE ASSISTANT DEPUTY

16 DIRECTOR WITH PUBLIC WORKS.

17

18 SUP. YAROSLAVSKY, CHAIRMAN: THERE'S A GROUP OF THREE CITIZENS

19 WHO HAVE BEEN REVIEWING ALL OF THESE ISSUES WITH YOU, IS THAT

20 CORRECT?

21

22 JACOB WILLIAMS: THE PAC, YES. THE PROJECT ADVISORY COMMITTEE.

23
24 SUP. YAROSLAVSKY, CHAIRMAN: YES, THE ADVISORY COMMITTEE. AND

25 THEY'VE BEEN LOOKING AT ALL OF THE CHANGE ORDERS AND COST
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1 OVERRUNS AND THAT'S BEEN THEIR CHARGE, TO TRY TO KEEP THE

2 PROJECT AS CLOSE TO BUDGET AS POSSIBLE?

4 JACOB WILLIAMS: IN REAL TIME.

6 SUP. YAROSLAVSKY, CHAIRMAN: DID THEY REVIEW THESE CHANGES?

8§ JACOB WILLIAMS: YES.

10 SUP. YAROSLAVSKY, CHAIRMAN: DID THEY ENDORSE THEM?

11

12 JACOB WILLIAMS: THEY REVIEWED THEM. THEY CONCURRED WITH THIS
13 CHANGE WITH RESPECT TO THE CONTRACTOR, YES.

14

15 SUP. YAROSLAVSKY, CHAIRMAN: EVERY ONE OF THE THREE...
16

17 JACOB WILLIAMS: YES.

18

19 SUP. YAROSLAVSKY, CHAIRMAN: ...CONCURRED IN THEM?

20

21 JACOB WILLIAMS: YES.

22

23 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. THANK YOU. I DON'T HAVE ANY
24 OTHER QUESTIONS. ANYBODY ELSE? DO YOU WANT TO MOVE IT? I SAID,

25 DO YOU WANT TO MOVE IT?
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SUP. MOLINA: OH, YES.

SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT, MOLINA MOVES. BURKE

SECONDS. UNANIMOUS VOTE. ALL RIGHT. WHAT ELSE DO WE HAVE?

PUBLIC COMMENT? I'M GOING TO CALL-- WE HAVE QUITE A FEW CARDS

ON PUBLIC COMMENT. I'LL CALL FOUR UP AT A TIME. STAAV

GOLDREICH, SYLVIA AL MALIKI. SUSAN GALEAS AND JAMES SMITH.

DEPUTY: THE FIRST FOUR PEOPLE WHO WERE CALLED, PLEASE STEP UP

SPEAKER: JAMES IS NOT HERE YET. SHE'S PARKING. BUT JUSTIN

COULD SPEAK.

SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. MISS GOLDREICH?

SPEAKER: NO.

STAAV GOLDREICH: YES, I'M MS. GOLDREICH.

SUP. YAROSLAVSKY, CHAIRMAN: OKAY. YOU'RE FIRST.

STAAV GOLDREICH: ALL RIGHT, I'M A SENIOR IN THE DANCE

DEPARTMENT OF L.A. COUNTY HIGH SCHOOL FOR THE ARTS. I'VE BEEN

THERE ALL FOUR YEARS AND I'VE SEEN THE CHANGE THAT HAS
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1 OCCURRED FROM MY FRESHMAN YEAR TO MY SENIOR YEAR. THE FIRST
2 THREE YEARS I WAS AT THIS SCHOOL, TECHNIQUE WAS STRESSED. YOU
3 HAD TWO TECHNIQUE CLASSES A WEEK, THAT'S BALLET, AND THAT

4 PREPARED YOU FOR COLLEGE, FOR AUDITIONS, FOR JUST THE DANCE

5 WORLD IN GENERAL. THIS YEAR, I HAVE HAD ONE TECHNIQUE CLASS IN
6 THE BEGINNING OF THE YEAR AS AN ELECTIVE. AS THE YEAR

7 PROGRESSED, AND WE HAVE HAD TEACHERS WHO WERE PUSHED TO LEAVE,
8 FIRED OR LEFT ON THEIR OWN ACCORD BECAUSE OF THE

9 ADMINISTRATION, I'VE HAD TWO CLASSES A WEEK. THAT MEANS THREE
10 CLASSES I WAS SITTING OUT. NO TEACHER. OFTEN, THERE WAS NO

11 CLASS TO WORK IN. WE WERE KICK OUT OF THE ROOM BECAUSE THERE
12 WAS A COLLEGE CLASS THAT WASN'T ARRANGED PROPERLY. WE HAD TO
13 WORK OUT ON THE CONCRETE, WHICH IS VERY, VERY UNHEALTHY FOR

14 DANCERS. WE'VE-- THE TEACHERS WHO DIDN'T WANT TO PUT THEIR

15 DANCERS IN THIS KIND OF DANGER, THEY SACRIFICED THEIR CLASS SO
16 WE DIDN'T HAVE THAT PREPARATION FOR COLLEGE. AND, FOR SENIORS,
17 THIS YEAR IS THE MOST IMPORTANT. THIS IS THE YEAR WHERE YOU

18 COMPLETE YOUR TRAINING. I DIDN'T HAVE ANY OF THAT. SAFETY.

19 THIS CONCRETE ISSUE. BESIDES THAT, THROUGH OUR SHOWS, WE

20 FINALLY BOUGHT MARLEY FOR OUR STAGE. THE MARLEY WASN'T

21 PREPPED. WE HAD MANY PEOPLE FALLING. THERE COULD HAVE BEEN

22 SERIOUS INJURIES. AND WE'VE HAD A PROBLEM WITH THE CALL TIMES.

23 YOU KNOW, WE WEREN'T TOLD THE PROPER CALL TIMES. WE WERE
24 SITTING OUT IN THE COLD WITHOUT SUPERVISION BY OURSELVES FOR

25 MAYBE AN HOUR. WHEN WE TRIED TO SPEAK OUT ABOUT THESE ISSUES
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1 THAT HAVE COME UP THROUGH THE COURSE OF THE YEAR, WE WERE
2 THREATENED WITH PROBATION, NOT WALKING DURING GRADUATION. WE

3 WERE LIED TO BY THE ADMINISTRATION AND THAT'S WHAT LEADS ME TO
4 BELIEVE THAT THE ADMINISTRATION ISN'T DOING WHAT'S BEST FOR US

5 BUT WHAT'S EASIEST FOR THEM.

7 SUP. YAROSLAVSKY, CHAIRMAN: OKAY. SYLVIA AL MALIKIT.

9 SYLVIA AL MALIKI: AL MALIKT.

10

11 SUP. YAROSLAVSKY, CHAIRMAN: OH, AL MALIKI. I'M SORRY.

12

13 SYLVIA AL MALIKI: AS YOU SAID, MY NAME IS SYLVIA AL MALIKI AND
14 I AM ALSO A SENIOR BUT I AM THE DANCE REPRESENTATIVE OF THE
15 DEPARTMENT AND I AM HERE TODAY BECAUSE THE ARTISTIC INTEGRITY
16 OF THE DANCE DEPARTMENT IS FALLING INTO DARKNESS AND PEOPLE
17 ARE EITHER NONCHALANT BECAUSE THEY DO NOT CARE OR THEY ARE

18 IGNORANT BECAUSE THEY HAVEN'T BEEN INFORMED. WE'VE HAD TWO

19 PEACEFUL PROTESTS WHICH THE STUDENTS WOULD WALK OUT DURING

20 THEIR ARTS TIMES AND THIS IS LIKE-- WE DIDN'T WANT TO DO IT
21 BUT WE WEREN'T BEING HEARD. WE HAD NO OTHER CHOICE. AND I WAS

22 PERSONALLY BLACKMAILED BY OUR PRINCIPAL, MR. GOTHOLD, WHO TOLD

23 US THAT, IF WE CONTINUED TO PROTEST, HE MIGHT NOT REWARD US
24 WITH OUR MEETING THAT WAS PROMISED TO US ON THE 24TH SO WE HAD

25 TO HAVE THE MEETING A DAY LATER WITH DAVID FLORES AND I HAD TO
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1 LEAVE BECAUSE OF AN APPOINTMENT. AND, ONCE I LEFT, IT WAS
2 CIRCULATED THAT SOMEONE TOLD DAVID FLORES THAT THE STUDENTS

3 DID NOT WISH TO MEET WITH HIM, WHICH WAS TOTALLY INCORRECT.

4 THE FIRST TIME WE WERE ACTIVE WAS AT A PARENT MEETING WHEN THE
5 STUDENTS WERE ASKED TO SPEAK BECAUSE, LIKE STAAV STATED, WE DO
6 NOT HAVE STRONG TECHNIQUE CLASSES AND, WITH OTHER PROFESSIONS,
7 YOU NEED CERTAIN CLASSES OR CERTAIN SKILLS IN ORDER TO BE THE
8 BEST YOU CAN BE AT THAT PROFESSION. SAME WITH DANCE. WE HAVE

9 NOT HAD THOSE CLASSES. AND SO WE WERE SPEAKING ABOUT IT,

10 SAYING OUR FUTURE IS AT RISK AND, WHILE THESE PARENTS ARE

11 BICKERING OR BEING BITTER, THAT OUR FUTURES ARE AT STAKE AND
12 WE WERE PHYSICALLY YELLED AT BY THE PARENTS FOR VOICING OUR

13 OPINIONS. IT'S ALSO BEEN SPECULATED THAT THIS IS A RACE ISSUE.
14 IT IS NOT A RACE ISSUE. TO PREVENT THE STUDENTS FROM GETTING
15 INTO ANY MORE DANGERS OF PROBATION, WE HAD T-SHIRTS THAT SAID
16 "PROTECT OUR LEGACY", WHICH WAS THE LEGACY OF THE DANCE

17 DEPARTMENT ITSELE AND NOT THE LEGACY OF AN INDIVIDUAL PERSON.
18 NOT ONLY DID THEY COMPLETELY MISINTERPRET WHAT THE "PROTECT

19 OUR LEGACY" MEANT BUT THEY ALSO SAID THAT NO STUDENTS OF COLOR
20 WORE THAT SO I BASICALLY THOUGHT APPARENTLY I MUST BE WHITE

21 BECAUSE I'M THE ONE THAT GOT ALL THE STUFF TOGETHER. AND NOT

22 JUST STUDENTS, AFRICAN-AMERICAN STUDENTS WORE THEM BUT ALSO

23 FILIPINOS, HISPANICS, MANY STUDENTS WROTE THAT SO THE LETTER
24 THAT WAS RECEIVED BY OUR DEPARTMENT HEAD WAS INCORRECT AND

25 WASN'T ACCURATE AT ALL. I'VE ALSO HELPED WITH THE LACHSA DANCE
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1 AUDITIONS AND IT SADDENS ME BECAUSE ALL THE GREAT THINGS THAT
2 WE ONCE HAD, COLLEGE CONNECTIONS AND STRONG CLASSES, ALL I

3 COULD TALK ABOUT AND INFORM THE PARENTS ABOUT WERE THINGS THAT
4 NO LONGER EXISTED AT THIS SCHOOL. AND I'M NO LONGER FIGHTING

5 HERE FOR MY RIGHTS BECAUSE I AM A SENIOR AND IT IS TOO LATE

6 FOR ME. I'M FIGHTING FOR THE FUTURE CLASSES SO THAT THEY CAN

7 HAVE A CHANCE AND STAND WHEN THEY GO TO COLLEGE SO THAT THEY

8 CAN FEEL PREPARED. BECAUSE, AT THIS MOMENT RIGHT NOW, WITHIN

9 FOUR YEARS, THERE WILL NOT BE A DANCE DEPARTMENT BECAUSE THE
10 PEOPLE THAT MADE THE DEPARTMENT SO GREAT ARE GONE. AND WE HAD
11 NINE TEACHERS. ONLY THREE OF THE ORIGINAL TEACHERS ARE THERE
12 AND ONE IS ABOUT TO QUIT. SO ONLY TWO ORIGINAL TEACHERS ARE

13 THERE. SO THIS IS A VERY SERIOUS ISSUE.

14

15 SUP. YAROSLAVSKY, CHAIRMAN: OKAY, THANK YOU. SUSAN GALEAS.

16 BEFORE YOU GO ON, IS JAMES SMITH HERE? JUSTIN WHEELER? TRICIA
17 THAYER? IS TRICIA HERE? NO? RHONDA? OH, YOU'RE HERE. COME ON
18 DOWN. OKAY. THAT'S ALL THERE IS THAT WE'LL CALL FOR NOW. OKAY,
19 MS. GALEAS.

20

21 SUSAN GALEAS: GOOD MORNING, COUNTY SUPERVISORS, MY NAME IS

22 SUSAN GALEAS AND I'M A PARENT OF A THIRD YEAR VOCAL MUSIC

23 STUDENT AT THE L.A. COUNTY HIGH SCHOOL FOR THE ARTS, AS WELL
24 AS CO-PRESIDENT OF THE FRIENDS OF ARTS HIGH ORGANIZATION. I'M

25 HERE TODAY TO ELUCIDATE FOR YOU THE CURRENT SITUATION AT

The Meeting Transcript of
The Los Angeles County Board of Supervisors
74



April 10, 2007

The Meeting Transcript of
The Los Angeles County Board of Supervisors

1 LACHSA. FIRST, I'D LIKE TO PAINT A PICTURE OF THE LACHSA
2 CULTURE, AS SEEN THROUGH THE EYES OF STEVE BARBER, A

3 FACILITATOR HIRED BY SUPERINTENDENT DARLENE ROBLES TO HELP

4 RESOLVE THE MULTIPLE ISSUES THAT ARE ADVERSELY AFFECTING THE

5 SCHOOL. FOLLOWING ARE STATEMENTS, VERBATIM, FROM A RECENT

6 DOCUMENT SENT TO US BY STEVE BARBER. "US VERSUS THEM PERMEATES
7 THE SCHOOL CULTURE. WE HAVE ENCOUNTERED A CULTURE OF CONFLICT
8 WHEREIN THE UNCONSCIOUS COMPETENCE OF ALL PARTIES EVOLVES TO

9 AN ANTAGONISTIC CRESCENDO IN SUCH A FASHION THAT ALL

10 ENGAGEMENTS, CONVERSATIONS AND ISSUES ARE EVALUATED THROUGH A
11 LENS OF SIDES." "IT BECAME APPARENT TO THE FACILITATORS THAT
12 THE APPLICATION OF PROCESS TO ADDRESS THE LONG-TERM SYSTEMIC
13 ISSUES WAS BEING MADE MORE DIFFICULT BY THE INTENSITY OF

14 EMOTION AND EMOTION-DRIVEN BEHAVIORS SUCH AS LANGUAGE,

15 SUSPICION AND ASSUMPTIONS, THAT AN IMMEDIATE STEP NEEDED TO BE
16 TAKEN TO ADDRESS THE EMERGENT ISSUE OF THE PRESENCE OF ONE OF
17 THE STAKEHOLDERS IN THE RELATIONSHIP. ACCORDINGLY, THE

18 FACILITATORS HAVE INITIATED A SECONDARY MEDIATION PROCESS TO
19 ADDRESS THIS ISSUE." WHILE THIS IS FANCY LANGUAGE, IT

20 NONETHELESS PAINTS A CLEAR PICTURE FROM AN OBJECTIVE

21 PERSPECTIVE THAT THIS IS A SCHOOL THAT HAS BECOME SEVERELY,

22 SEVERELY FRACTURED BY INCOMPETENCE AND ALONG THE LINES OF RACE

23 AND POSITION. THE TRUE MISSION OF THE SCHOOL SEEMS TO HAVE
24 BEEN FORGOTTEN AND OUR KIDS ARE SUFFERING. AND IN SPITE OF

25 WHAT YOU MAY HAVE HEARD, THEY AREN'T SUFFERING BECAUSE THE
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1 PARENTS ARE CREATING CHAOS. THEY'RE SUFFERING BECAUSE THEY
2 HAVE INADEQUATE SUPERVISION, LESS THAN ADEQUATE CLASSROOM
3 SITUATIONS AND, IN ONE DEPARTMENT THIS YEAR, LITTLE TO NO ARTS
4 INSTRUCTION. THIS IS NOT A PICTURE ONE WOULD EXPECT OF A

5 NATIONALLY RECOGNIZED, AWARD-WINNING ARTS HIGH SCHOOL, IS IT?
6 AS A PARENT, COMMUNITY PROFESSIONAL AND A TAXPAYER, I HAVE

7 PERSONALLY ASKED THE LACHSA ADMINISTRATION AND L.A.C.O.E. WHY
8 THIS IS HAPPENING AT OUR SCHOOL AND THE ANSWERS I HAVE

9 RECEIVED ARE ABYSMAL. I HAVE BEEN TOLD THAT THE PROBLEM LIES
10 WITHIN THE PARENTS BEING MEDDLESOME, OVERLY CONCERNED ABOUT

11 THE EDUCATION AND WELLBEING OF THEIR CHILDREN. SHOULD PARENTS
12 NOT BE CONCERNED AND ACTIVELY INVOLVED? I HAVE BEEN TOLD THAT
13 THE LONG LIST OF GRIEVANCES BROUGHT FORTH BY CONCERNED PARENTS
14 WERE MANUFACTURED DUE TO RACISM. I AM NOT A RACIST. TAYIOR,

15 STAND UP, PLEASE. THAT IS MY DAUGHTER. SHE IS BIRACIAL. THIS
16 IS NOT ABOUT RACE. HOWEVER, THANKS TO THE EFFORTS OF CERTAIN
17 INDIVIDUALS IN LACHSA'S ADMINISTRATION, THERE IS NOW A

18 PERCEPTION THAT THIS IS ABOUT RACE AND STUDENTS AND PARENTS

19 ARE NOW BECOMING DIVIDED ALONG THOSE LINES WITH STUDENTS

20 FIGHTING STUDENTS AND PARENTS FIGHTING PARENTS. THE REAL

21 ISSUES ARE DOCUMENTED AND FOUNDED AND THEY REVOLVE AROUND

22 COMPETENCY. EVEN L.A.C.0.E.'S DAVID FLORES ACKNOWLEDGED SOME

23 OF THEM IN HIS FEBRUARY REPORT. YET THE OTHER SIDE,
24  QUOTE/UNQUOTE, "HAS DONE A PRETTY GOOD JOB OF WATERING DOWN

25 THE REAL ISSUES WITH LOUD CRIES OF RACISM". I HAVE BEEN TOLD
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1 THAT L.A.C.0.E. IS ANGRY AT THE FRIENDS OF OUR TIE

2 ORGANIZATION BECAUSE OF A VOTE OF NO CONFIDENCE REGARDING A

3 DEPARTMENT CHAIR WAS PLACED ON THE FOA SECTION OF THE SCHOOL'S
4 WEBSITE. THIS AFTER YEARS OF BRINGING FORTH GRIEVANCES TO THE
5 SCHOOL'S PRINCIPAL WITH NO RESPONSE TO DATE AND MONTHS OF

6 BRINGING ISSUES TO L.A.C.O.E.'S ATTENTION WITH NO REAL

7 RESPONSE TO DATE. A LETTER THAT RESULTED FROM A VOTE THAT TOOK
8 PLACE IN A NOVEMBER MEETING IN WHICH THE ONLY NAY WAS THE VICE
9 PRINCIPAL AND THAT LETTER WAS SENT AS AN ADDENDUM TO THE

10 MINUTES TO THE PRINCIPAL AND THE VICE PRINCIPAL TWICE WITH NO
11 INDICATION THAT THERE WERE ANY PROBLEMS BEFORE IT WAS POSTED,
12 WHICH WAS CONSISTENT WITH HOW THE MINUTES HAD BEEN POSTED

13 PREVIOUSLY. THIS, IN AND OF ITSELF, IS A CLEAR INDICATION OF
14 THE SYSTEMIC ISSUES IMPACTING THE SCHOOL, WHEN NEITHER THE

15 PRINCIPAL NOR THE VICE PRINCIPAL HAVE EITHER THE TIME OR THE
16 INCLINATION TO READ AND RESPOND TO THOSE "MEDDLESOME PARENTS"
17 AND, ONCE THE LETTER WAS SEEN, WHAT DID L.A.C.O.E. DO BUT

18 SHOOT THE MESSENGER AND FIRE THE PARENTS. AND I'VE LEARNED

19 THAT THE PROBLEMS WE SHARED WITH YOU THROUGH THE INFORMATION
20 PROVIDED TO EACH OF YOUR OFFICES EARLIER THIS YEAR IN THESE

21 BINDERS, COMMUNICATED HERE AGAIN TODAY, HAVE OCCURRED OVER AND

22 OVER AND OVER AGAIN WITH EACH NEW PRINCIPAL. DID YOU KNOW THAT

23 LACHSA HAS HAD FOUR PRINCIPALS SINCE 2000? THAT'S FOUR

24 PRINCIPALS IN LESS THAN SEVEN YEARS. THAT'S A VERY CLEAR

25 INDICATION THAT SOMETHING IS TERRIBLY WRONG IN THE LAND OF OZ.
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1 I THINK YOU NEED TO ASK L.A.C.O.E. THE QUESTION OF WHY.

2 CAN'T THEY HIRE AND KEEP A GOOD PRINCIPAL? I UNDERSTAND THAT

3 THE PRINCIPAL PRIOR TO THE CURRENT ONE WAS VERY WELL QUALIFIED
4 AND VERY WELL RESPECTED. WHAT HAPPENED WITH HER? PERHAPS

5 SOMEONE FROM THIS BOARD NEEDS TO ASK THE QUESTION AND DON'T

6 ASK L.A.C.0O.E. BECAUSE YOU WON'T GET THE REAL ANSWER. IF YOU

7 DON'T BELIEVE ME OR THE STUDENTS HERE TODAY OR THE ALUMNI THAT
8§ WILL SPEAK TO YOU IN A MOMENT, PLEASE CONTACT THE LACHSA

9 FOUNDATION BOARD OF DIRECTORS OR STAFF, MARSHA HOBBS, THE

10 BOARD CHAIR OF THE FOUNDATION, SHEILA BERGMAN, THE EXECUTIVE
11 DIRECTOR OF THE FOUNDATION. THEY CAN SHARE WITH YOU THEIR OWN
12 OBSERVATIONS ABOUT THE SCHOOL'S HISTORY AS WELL AS THE CURRENT
13 DATLY CHALLENGES AND THEY CAN'T BE ACCUSED OF BEING MEDDLESOME
14 PARENTS. THE TRUTH IS SIMPLE. LACHSA IS BROKEN.

15

16 SUP. YAROSLAVSKY, CHAIRMAN: I'M GOING TO ASK YOU TO FINISH IF
17 YOU CAN. I'VE GIVEN YOU A LOT MORE TIME.

18

19 SUSAN GALEAS: OKAY. AND IT NEEDS IMMEDIATE REPAIR. AND THERE
20 IS NO COMMUNICATION. I'LL SUBMIT THIS SO THAT YOU ALL HAVE IT
21 BECAUSE I HAVE ANOTHER PAGE. NORMALLY I TALK FAST. THE

22 SCHOOL'S ADMINISTRATION NEEDS A COMPLETE OVERHAUL. AND WE LOOK

23 TO YOU, ONE OF WHOM IS A FOUNDER OF LACHSA, DO THE RIGHT
24 THINGS BY THE STUDENTS. L.A.C.O.E. NEEDS TO ADDRESS THE ISSUES

25 AND QUIT BLAMING THE PARENTS.
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SUP. YAROSLAVSKY, CHAIRMAN: OKAY. IF WE CAN GET A COPY.

WILL YOU GET A COPY OF THAT FROM MS. GALEAS?

SUSAN GALEAS: THANK YOU.

SUP. YAROSLAVSKY, CHAIRMAN: JUSTIN WHEELER?

JUSTIN WHEELER: YES, SIR. MY NAME IS JUSTIN WHEELER. I'M
ACTUALLY AN ALUMNUS OF LOS ANGELES COUNTY HIGH SCHOOL FOR THE
ARTS. I GRADUATED IN 1994 AND I ACTUALLY THIS THE HONOR OF
SHAKING A COUPLE OF YOUR HANDS DURING MY GRADUATION CEREMONY.
THIS SHOULD FEEL VERY FAMILIAR TO YOU. I ACTUALLY SPOKE IN
FRONT OF THIS BODY IN 1994. I WAS A LITTLE PIMPLELY-FACED 16
YEAR OLD KID BUT THIS SHOULD FEEL VERY FAMILIAR. THE ISSUES
THAT WE ARE FACING NOW AT THE ARTS HIGH SCHOOL, WHERE TEACHERS
AND STUDENTS ARE AFRAID TO SPEAK OUT, THEY HAVE TO SUBMIT
LETTERS ON CAMPUS UNDER A PSEUDONYM BECAUSE THEY'RE AFRAID
THAT, IF THEY SUBMIT LETTERS UNDER THEIR OWN NAME, THEY'RE
GOING TO BE TERMINATED FROM THE SCHOOL, IF THEY'RE A TEACHER,
OR THEY'RE GOING TO BE PREVENTED FROM WALKING IN GRADUATION,
IF THEY'RE A STUDENT. I FACED THAT SAME THING IN 1994. THE
PROBLEMS WERE THERE THEN. THEY'VE ACCELERATED DRAMATICALLY IN
THE LAST FIVE YEARS AT THE ARTS HIGH SCHOOL. IT'S REALLY A

TRAGEDY WHAT'S HAPPENING AT THAT SCHOOL. THE REASON THE BOARD
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1 OF SUPERVISORS IS HEARING ABOUT THIS TODAY IS BECAUSE WE'VE
2 TRIED TO GO THROUGH THE COUNTY BOARD OF EDUCATION. WE'VE TRIED
3 TO GO THROUGH THE COUNTY OFFICE OF EDUCATION TO ADDRESS THIS

4 ISSUE. WE HAVE SUBMITTED LETTERS REPEATEDLY OVER THE LAST

5 SEVERAL YEARS, FORMAL LETTERS OF COMPLAINT WHICH HAVE BEEN

6 SIMPLY IGNORED. WE HAVE BEEN LIED TO BY MEMBERS OF THE COUNTY
7 OFFICE OF EDUCATION, PEOPLE FROM THE SUPERINTENDENT'S OFFICE.
8§ WE'VE BEEN STONEWALLED. THEY DO THIS PROCESS EVERY YEAR. EVERY
9 YEAR THERE'S A NEW CROP OF PARENTS THAT DON'T KNOW WHAT THE

10 PROBLEMS WERE THE YEAR BEFORE AND THEY JUST BRING THOSE PEOPLE
11 IN AND KEEP RUNNING THEIR LITTLE GAME. IT SEEMS LIKE A PRETTY
12 COOL SHOW THAT THEY DO BUT IT'S GOTTEN TO THE POINT WHERE IT'S
13 RIDICULOUS. MR. ANTONOVICH, YOU AND I HAD A PHONE CONVERSATION
14 IN 1994 AFTER MY GRADUATION. YOU PROBABLY DON'T REMEMBER IT.

15 BUT YOU ASKED ME AT THAT TIME, "I SEE THAT THERE ARE SERIOUS
16 PROBLEMS AT THIS SCHOOL. WHAT NEEDS TO BE DONE? WHAT CAN BE

17 DONE?" AND, AS A 16-YEAR-OLD KID NOT KNOWING A LOT, I SAID,

18 "HEY, YOU KNOW WHAT? I THINK LACHSA NEEDS TO BE RE-CHARTERED.
19 IT SEEMS LIKE THE DIVISION OF ALTERNATIVE EDUCATION UNDER THE
20 COUNTY OFFICE OF EDUCATION IS NOT WELL EQUIPPED TO MANAGE THIS
21 SCHOOL. IT'S SIMPLY STRUGGLING TO DO IT. MAYBE IT'S NOT THEIR

22 AREA OF EXPERTISE. THEY DO A LOT OF JUVENILE DELINQUENT

23 SCHOOLS AND COURT SCHOOLS. MAYBE THE COUNTY OFFICE OF

24  EDUCATION CAN ADMINISTRATE IT BUT THE DIVISION OF ALTERNATIVE

25 EDUCATION IS NOT THE RIGHT PLACE FOR IT TO SIT." I DON'T KNOW
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1 THE COMPLEXITIES OF THE BUDGET ISSUES AS TO WHY IT WAS

2 INTO THAT DIVISION BUT THE SYSTEMIC PROBLEMS THAT RECUR YEAR

3 AFTER YEAR ARE SIMPLY THE EMPIRICAL EVIDENCE THAT YOU GUYS

4 SHOULD LOOK AT TO REALIZE THAT THIS PROBLEM CANNOT BE SOLVED

5 WITHIN L.A.C.0.E. WE'RE ASKING YOU GUYS, FROM THE OUTSIDE, TO
6 DO WHAT IT IS YOU GUYS NEED TO DO TO SAVE THIS SCHOOL AND

7 PROTECT IT BECAUSE IT REALLY IS SUFFERING. I HAVE A COUPLE OF
8 LETTERS THAT I'D LIKE TO SUBMIT. ONE IS FROM THE TREASURER

9 FROM THE FRIENDS OF ARTS HIGH AND ANOTHER IS AN ARTICLE THAT
10 WAS PUBLISHED BY A LACHSA TEACHER WHO, IN FEAR OF HIS JOB,

11 SUBMITTED THIS LETTER ANONYMOUSLY TO A LOCAL NEWSPAPER.

12

13 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. TRICIA THAYER. IS THIS
14 THE LAST OF THE LACHSA TESTIFIERS? THE LAST ONE THAT I HAVE, I
15 THINK. ALL RIGHT. I THINK WE NEED TO GET THE SUPERINTENDENT

16 DIRECTLY INVOLVED IN THIS. I DON'T KNOW WHAT TO PROPOSE RIGHT
17 OFF THE TOP OF MY HEAD AND I'M RELUCTANT TO SHOOT FROM THE HIP
18 OR THE LIP BUT I THINK WE OUGHT TO ENGAGE THE SUPERINTENDENT
19 DIRECTLY ON THE ISSUES THAT HAVE BEEN RAISED AND MAYBE NEXT

20 WEEK HAVE A DISCUSSION. I'LL GIVE HER A CALL MYSELF. I'M SURE
21 OTHER MEMBERS MAY WANT TO DO THAT. BUT WE'VE HAD-- THIS IS NOT

22 THE FIRST TIME WE'VE HAD IT HERE AND IT'S NOT THE FIRST TIME--

23 THIS IS NOT THE ONLY VENUE IN WHICH THESE COMPLAINTS HAVE BEEN
24 RAISED, AT LEAST WITH ME. SO I JUST THINK WE NEED TO GET IT AT

25 THE HIGHEST LEVELS. I'M NOT SAYING WHO'S RIGHT AND WHO'S WRONG
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1 BUT IT NEEDS TO GET AT THE HIGHEST LEVELS. SO WE'LL WORK ON
2 THAT. AND, UNLESS ANYBODY ELSE HAS AN ALTERNATIVE IDEA OR A

3 BETTER IDEA, I THINK WE NEED TO DO THAT. ALL RIGHT. THANK YOU
4 FOR BEING HERE AND FOR YOUR INTEREST IN THE SCHOOL. THE

5 SCHOOL'S ONLY AS GOOD AS ITS STUDENTS AND ITS PARENTS AND ITS
6 STAFF SO PARENTS ARE A VERY IMPORTANT PART OF THAT. APPRECIATE
7 IT. ALL RIGHT. TRICIA THAYER, RHONDA KING AND OLGA RAMIREZ?

8 TRICIA THAYER?

10 TRICIA THAYER: DO YOU WANT ME TO START?

11

12 SUP. YAROSLAVSKY, CHAIRMAN: YES.

13

14 TRICIA THAYER: YEAH, MY NAME IS TRICIA THAYER AND MY ADDRESS
15 IS 1572 HERBERT AVENUE, NUMBER 6. AM I SUPPOSED TO ADDRESS YOU
16 GUYS HONORABLE SUPERVISORS BECAUSE I NEVER DO-- SO, ANYWAY, I
17 HAVE A QUESTION FOR YOU AS TO WHETHER OR NOT, REGARDING THE
18 DEPARTMENT, AS TO WHETHER OR NOT YOU CONDONE THEM ENGAGING IN
19 CHICANERY AND LYING BECAUSE THAT'S WHAT THEY'RE UP TO. I WON
20 MY APPEAL BUT I DIDN'T HAVE HOUSING AT THE TIME FOR MY

21 CHILDREN. I KNOW YOU GUYS HAVE HEARD THIS STORY BEFORE BUT

22 APPARENTLY MICHAEL ANTONOVICH SAYS HE EXPECTS ME. I DON'T KNOW

23 WHAT THAT MEANS. ARE YOU GOING TO JUST, LIKE, KEEP MY KIDS SO
24 I CAN KEEP DRAGGING DOWN HERE? BUT, ANYWAY, SO I MADE A DEAL

25 WITH THE DEPARTMENT THAT, WHEN I GOT HOUSING, I WOULD GET MY
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1 KIDS BACK. NOT ONLY THAT BUT THEY WOULD HELP ME WITH HOUSING.
2 AND I'M ASKING YOU WHETHER OR NOT THEY'RE HONORABLE AND DO

3 THEY HONOR THEIR DEALS? AND SINCE YOU'RE OVER THE DEPARTMENT,
4 I'D LIKE TO TALK TO SOMEBODY BESIDES THE DEPARTMENT. I DON'T

5 KNOW WHY I SHOULD TALK TO THE DEPARTMENT ABOUT THE DEPARTMENT.
6 S50, ANYWAY, SO I PLED NO CONTEST TO A NEW PETITION IN

7 EXCHANGE, IN ADDITION TO WAIVING MY RIGHTS TO AN APPEAL, IN

8 EXCHANGE FOR HELP, QUOTE/UNQUOTE, WITH HOUSING. I EVEN HEARD

9 THE WORDS COME OUT OF JUDGE NANCY BROWN'S MOUTH HERSELF THAT,
10 "OH, YEAH, MAYBE THEY CAN PUT YOU AT THE TOP OF THE SECTION 8
11 WAITING LIST."™ BLAH, BLAH, BLAH. AND THEN, RON ROSS, AFTER TWO
12 MONTHS, YOU KNOwW, I CALLED HIM AND IT IS ALL I COULD DO TO

13 TALK HIM INTO PUTTING ME ON THE WAITING LIST, WHICH I DON'T

14 EVEN KNOW IF HE DID THAT. SO, IN OTHER WORDS, I WAS LIED TO.
15 SO NOW I HAVE HOUSING. THE LEAST THE DEPARTMENT COULD DO IS

16 GIVE ME BACK MY KIDS LIKE THEY'RE SUPPOSED TO DO. YOU KNOW,

17 I'VE BEEN TOLD THAT FOR THREE YEARS AND THAT'S WHAT I TELL MY
18 CHILDREN. OTHERWISE, THEY'RE LYING TO ME. AND I WANT TO KNOW
19 IF YOU CONDONE THAT. WHAT THE DEPARTMENT HAS DONE TO ME AND

20 OTHER MOTHERS BECAUSE THE SYSTEM DOES NOT HELP MOTHERS IS

21 CRIMINAL. AND I'LL WRITE A BOOK ABOUT IT AND THEN YOU'LL KNOW,

22 OTHERWISE I DON'T HAVE TIME TO GO INTO IT. BUT I JUST WANT TO

23 KNOW IF THAT'S WHAT SOCIETY DOES TO MOTHERS IS DO THEY JUST

24 CAST THEM OUT THERE TO ROT?

25
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1 SUP. YAROSLAVSKY, CHAIRMAN: OKAY.

3 TRICIA THAYER: THAT'S ALL I HAVE TO SAY.

5 SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. SUP. MOLINA'S OFFICE IS

6 WORKING WITH YOU AND THEY'LL CONTINUE TO DO SO. RHONDA KING?

8 RHONDA KING: GOOD MORNING. BOARD OF SUPERVISORS.

10 SUP. YAROSLAVSKY, CHAIRMAN: GOOD MORNING.

11

12 RHONDA KING: FIRST OF ALL, I APOLOGIZE FOR BRINGING-- I GUESS
13 IT'S NOT PERSONAL BECAUSE YOU ARE OVER THE SHERIFF'S

14 DEPARTMENT. I AM A L.A. COUNTY SHERIFF'S EMPLOYEE. I WORK AT
15 THE TWIN TOWERS JAIL. I WILL HAVE 26 YEARS WITH THE COUNTY ON
16 APRIL 20TH. I'VE BEEN WITH THE SHERIFF'S DEPARTMENT 22 OF

17 THOSE YEARS. IN 2001, I FILED A FAIR HOUSING AND EMPLOYMENT
18 COMPLAINT AND LAWSUIT AGAINST A LIEUTENANT WITH THE SHERIFF'S
19 DEPARTMENT. I WON THAT COMPLAINT. I WAS MOVED FROM WHERE I

20 WORKED TO CARSON STATION. I WAS HARASSED BY DEPUTIES AT CARSON
21 STATION. I WAS MOVED BACK TO MEN' CENTRAL JAIL FROM WHERE I

22 STARTED, HARASSED THERE BY A CIVILIAN SUPERVISOR WHERE I HAD

23 TO TAKE OFF ON STRESS. MOVED AGAIN AFTER LEAVING, GOING BACK
24 ON STRESS, 2003, AND THEN COMING BACK, HARASSED AGAIN BY

25 DEPUTIES AND CIVILIAN PERSONNEL. I HAVE GONE THROUGH THE
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1 BUREAU OF COMPLIANCE, WHICH OVERSEES THE PROBLEMS OF THE
2 SHERIFF'S DEPARTMENT. I WROTE YOUR BOARD LAST YEAR. OF THE

3 FIVE SUPERVISORS, SUPERVISOR ANTONOVICH, SUPERVISOR BURKE AND
4 SUPERVISOR MOLINA WROTE ME BACK AND SAID THAT YOU WOULD HAVE

5 THEN ROBERT TAYLOR, THE OMBUDSMAN FOR THE COUNTY, LOOK INTO MY
6 PROBLEM. ROBERT TAYLOR WROTE ME BACK AND SAID HE DID NOT

7 HANDLE THE SHERIFF'S DEPARTMENT'S PROBLEMS AND REFERRED ME

8 BACK TO THE BUREAU OF COMPLIANCE, OKAY? IF THE DEPUTY CAN GET-
9 - THESE ARE THE DOCUMENTATION FROM THE BUREAU OF COMPLIANCE

10 SAYING THAT THEY WOULD NOT HELP ME. THEY FOUND NO FORMAL

11 INVESTIGATION, NO CAUSE FOR FORMAL INVESTIGATION. HERE'S THE
12 FOUR COPIES FOR EACH SUPERVISOR. KNABE'S NOT HERE. I KNOW

13 KNABE IS NOT HERE, I'M SORRY. AND SO THEY BASICALLY GAVE ME

14 THE RUNAROUND, THE BUREAU OF COMPLIANCE. I'M SORRY I HAVE TO
15 TAKE OFF FOUR HOURS FROM MY JOB TODAY TO COME HERE BUT I AM AT
16 MY WIT'S END. I HAVE GONE THROUGH THE BUREAU OF COMPLIANCE. I
17 HAVE GONE THROUGH LOCAL 660. LOCAL 660 REPRESENTED-- WANTED TO
18 REPRESENT ME AND HER SUPERVISOR MADE HER NOT REPRESENT ME ON A
19 MEETING WITH OUR CAPTAIN, MARCH 21ST. THAT WAS THE SECOND TIME
20 LOCAL 660 WOULD NOT REPRESENT ME REGARDING MY HARASSMENT AND
21 $50 BEING TAKEN OUT OF MY CHECK EVERY DAY. I CANNOT AFFORD TO

22 LOSE MY JOB. I AM SUPPORTING A SON IN COLLEGE, WHO NEEDS MY

23 MEDICAL COVERAGE AT LEAST THREE MORE YEARS. I AM THE SOLE

24 PROVIDER OF MYSELF. I'M A SINGLE WOMAN. I AM BEING TAILED. I

25 STARTED GETTING TAILED AFTER MY COMPLAINT IN 2002. I GOT

The Meeting Transcript of
The Los Angeles County Board of Supervisors
85



April 10, 2007

The Meeting Transcript of
The Los Angeles County Board of Supervisors

1 PULLED OVER WITH MY SON IN THE CAR BY THE DEPUTY-- WHEN I
2 FILED THOSE TWO COMPLAINTS AGAINST THE DEPUTIES AT CARSON

3 STATION FOR HARASSING ME, I GOT PULLED OVER BY HIS FRIEND WITH
4 MY SON IN THE CAR SAYING THAT I HAD A WARRANT ON MY ARREST,

5 FOR MY ARREST AT THAT ADDRESS. THERE WASN'T NO WARRANT FOR MY

6 ARREST. HE JUST PULLED ME OVER FOR HARASSMENT, OKAY?

8 SUP. YAROSLAVSKY, CHAIRMAN: I APPRECIATE IT. YOUR TIME IS UP.
9 BUT, MA'AM, GO AHEAD AND CONCLUDE.

10

11 RHONDA KING: TO CONCLUDE, SUPERVISOR YAROSLAVSKY, I'M SORRY.
12

13 SUP. YAROSLAVSKY, CHAIRMAN: NO PROBLEM.

14

15 RHONDA KING: IN CONCLUSION, I WOULD JUST LIKE-- OKAY, I HAVE
16 CONTACTED THE SHERIFF'S DEPARTMENT, LEE BACA, I EMAILED HIM
17 TWO TIMES. HIS COMMANDER, ROBERTA ABNER, SHE'S SUPPOSED TO

18 HAVE LOOKED INTO THE SITUATION AND I NEVER HEARD FROM HER

19 AGAIN. THREE WEEKS AGO HIS NEW COMMANDER, TOM LANG, SAID HE
20 WAS GOING TO CALL ME BACK AND NEVER CALLED ME BACK. I AM BEING
21 HARASSED AT WORK. I AM BEING TAILED BY LONG BEACH P.D. WHEN I

22 LEAVE MY HOUSE. THIS IS ALL FOR A COMPLAINT AGAINST LIEUTENANT

23 AND TWO DEPUTIES AND RECENTLY BEING HIT BY THE ELECTRONIC GATE
24 IN THE TOWER 2. FILED A COMPLAINT AGAINST THE TOWER 2 GATE.

25 I'M SORRY TO BRING THIS TO THE BOARD'S ATTENTION BUT I'M AT MY
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1 WIT'S END BECAUSE I HAVE GONE THROUGH ALL THE AVENUES THAT T

2 CAN REGARDING THE SITUATION.

4 SUP. YAROSLAVSKY, CHAIRMAN: YEAH, AND HERE'S THE PROBLEM.
5 YOU'VE GONE TO ALL THE AVENUES AND THEY'VE ALL, I GUESS, SAID

6 THE SAME THING. THEY HAVEN'T TAKEN UP YOUR CASE.

8 RHONDA KING: YES.

10 SUP. YAROSLAVSKY, CHAIRMAN: WE'RE NOT GOING TO BE IN THE

11 POSITION-- I DON'T KNOW WHAT WE KNOW THAT YOUR UNION DOESN'T
12 KNOW, THAT THE OMBUDSMAN DOESN'T KNOW, THAT THE DEPARTMENT
13 DOESN'T KNOW, I WOULDN'T NECESSARILY TRUST ANY DEPARTMENT IN
14 THAT SITUATION, BUT THE OTHERS ARE CHARGED WITH THE

15 RESPONSIBILITY OF BACK STOPPING IT. SO I HONESTLY DON'T KNOW
16 WHAT WE CAN DO.

17

18 RHONDA KING: CAN I MAKE ONE SUGGESTION?

19

20 SUP. YAROSLAVSKY, CHAIRMAN: HANG ON A SECOND. SUP. MOLINA

21 ADVISED ME THAT HER OFFICE AND HER STAFF HAS BEEN WORKING WITH

22 YOU ON THIS. THE ONLY THING THAT WE COULD DO NOW IS START YOU

23 RUNNING THROUGH THE SAME THING AGAIN BUT I'M NOT INCLINED TO

24 SUGGEST THAT WE DO THAT. BOB TAYLOR AS AN OMBUDSMAN RAN A GOOD

25 SHOP. HE'S GOT A NOSE FOR PROBLEMS. AND I DON'T THINK HE WOULD
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3 SO I CAN'T BE THE JUDGE.

4 SATID HERE TODAY.

9 HIS COMMANDER.

10

13

15

18

20

22 ELECTORATE.

23

1 HAVE OVERLOOKED THEM. THE UNION, LOCAL 660, IS A VERY

2 AGGRESSIVE REPRESENTATIVE OF ITS EMPLOYEES FROM WHERE I SIT.

I DON'T KNOW ANYTHING ABOUT WHAT YOU

6 RHONDA KING: AND THERE'S THE DOCUMENTATION THAT YOU GUYS BOTH
7 HAVE-- ALL HAVE. AND LIKE I SAID, AS THE SUPERVISORS OF LEE

8 BACA, BECAUSE I HAVE CONTACTED HIS OFFICE, HIS UNDERSHERIFF,

11 SUP. YAROSLAVSKY, CHAIRMAN: WE ARE NOT THE SUPERVISORS OF LEE

12 BACA. WE DO NOT SUPERVISE LEE BACA.

14 RHONDA KING: WHO SUPERVISES LEE BACA?

16 SUP. YAROSLAVSKY, CHAIRMAN: THE PEOPLE OF LOS ANGELES COUNTY

17 ELECT HIM. HE'S AN ELECTED OFFICIAL.

19 RHONDA KING: BUT HE ANSWERS TO THE BOARD OF SUPERVISORS.

21 SUP. YAROSLAVSKY, CHAIRMAN: NO, HE DOES NOT. HE ANSWERS TO THE
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1 RHONDA KING: SO, IN OTHER WORDS, YOU CANNOT CONTACT HIS OFFICE
2 FOR HIS DEPUTIES TO STOP HARASSING ME ON THE JOB AND OFF THE

3 JOB?

5 SUP. YAROSLAVSKY, CHAIRMAN: WELL, WE CAN CERTAINLY TRY TO DO
6 THAT BUT I THINK, YOU TOLD ME YOU'VE ALREADY BEEN IN TOUCH

7 WITH HIM DIRECTLY, PERSONALLY.

9 RHONDA KING: AND IT STOPPED FOR ABOUT A MONTH AFTER HE EMAILED
10 ME BACK AND THEN, LIKE I SAID, I HAD TO CONTACT HIS OFFICE

11 AGAIN THREE WEEKS AGO.

12

13 SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. WELL, I'LL TRY TO GET--
14 NOT TRY, I WILL GET YOUR PACKAGE FORWARDED TO THEIR

15 DEPARTMENT, TO HIM AND SEE WHAT HAPPENS.

16

17 RHONDA KING: SIR, I WOULD LIKE A MONITOR ASSIGNED TO ME FROM
18 THE OFFICE OF AFFIRMATIVE ACTION AND COMPLIANCE FOR THE COUNTY
19 TO MONITOR MY SITUATION. I FEEL UNSAFE ON MY JOB AND OFF THE
20 JOB. I'M REQUESTING THAT.

21

22 SUP. YAROSLAVSKY, CHAIRMAN: I DON'T KNOW THAT WE HAVE THE

23 AUTHORITY TO DO THAT. CERTAINLY, WE DON'T HAVE THE AUTHORITY
24 TO DO THAT TODAY. BUT, SHARON? OR RAY? EITHER ONE OF YOU?

25
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1 RAYMOND G. FORTNER, JR.: I DON'T BELIEVE THERE WOULD BE
2 AUTHORITY TO ASSIGN A MONITOR BUT, IF SHE HAS NOT DONE SO, SHE

3 COULD PERHAPS FILE A COMPLAINT WITH DENNIS DEFOYA'S OFFICE.

5 SUP. YAROSLAVSKY, CHAIRMAN: YEAH, PERHAPS YOU CAN TALK TO HER

6 ON THE SIDE AND GIVE HER SOME...

8 SHARON: WE'LL TALK TO HER.

10 SUP. YAROSLAVSKY, CHAIRMAN: ...AND GIVE HER SOME ADVICE. THANK
11 YOU. MS. RAMIREZ. OLGA RAMIREZ.

12

13 VOICE OF INTERPRETER: GOOD MORNING. I'M MRS. OLGA RAMIREZ. T
14 HAVE BEEN VOLUNTEERING FOR SIX YEARS AT THE HEALTH DEPARTMENT.

15 I AM PART OF THE COALITION OF LOS ANGELES FOR

16 VOLUNTEERS. THIS IS THE SECOND TIME I'M HERE TO ASK HELP FROM

17 SUPERVISOR MOLINA. WE HAVE BEEN WORKING ON THIS PROBLEM FOR

18 ABOUT APPROXIMATELY ONE YEAR AND NOTHING HAS BEEN RESOLVED.

19 THE DEPARTMENT OF MENTAL HEALTH CONTINUES TO ABUSE LATINOS. IN
20 THIS REPORT, WE HAVE REPORTED SEXUAL ABUSE. IN THIS REPORT, WE
21 HAVE REPORTED FRAUD, FEDERAL FRAUD. SHE ASKED ME FOR A REPORT

22 CONTAINING 33 PAGES, WHICH IS WHAT I HAVE ON HAND, WHICH WAS

23 ALSO SHARED WITH MARTHA JIMENEZ AND FOUR MEMBERS OF THE LATIN
24 COALITION. IT'S BEEN HARD WORK FOR ONE YEAR. UP TO NOW,

25 NOTHING HAS BEEN RESOLVED. THE COALITION GROUP HAS WORKED
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1 SHOULDER TO SHOULDER WITH PAPERS, PROMISES AND MEETINGS FOR A
2 WHOLE YEAR AND NOTHING HAS BEEN RESOLVED. WE'VE BEEN WORKING
3 HARD THIS WHOLE YEAR UNDER PROPOSITION 63. WE HAVE HAD

4 TRAINING, REIMBURSEMENTS, OFFICE, COMPUTERS. WE HAVE BEEN

5 FIGHTING FOR OUR RIGHTS. IT'S JUST BEEN A VERY HARD JOB FOR

6 THE WHOLE SIX YEARS INVOLVED AND NOBODY'S TAKING IT INTO

7 ACCOUNT AND THEY HAVE HAD NO RESPECT FOR THIS COALITION. THIS
8 GROUP, THIS COALITION IS ONLY ASKING THE DEPARTMENT OF MENTAL
9 HEALTH TO LET IT BE INDEPENDENT AND DON'T BE MANIPULATED BY
10 THEM AND NEED THE SUPPORT OF THE HEALTH SERVICES DEPARTMENT.
11 AS I EXPLAINED TO YOU, A REPORT HAS BEEN DONE AND THERE'S A
12 CONTINUATION OF USES AND OUR PAPERWORK HAS BEEN PREPARED AND
13 UP TO NOW NOTHING HAS BEEN RESOLVED. ALL I'M ASKING IS

14 SUPERVISOR MOLINA TO UNDERSTAND THAT WE JUST WANT TO BE AN

15 INDEPENDENT COALITION OF AMERICANS. WE CAN GROW AND HELP THE
16 COMMUNITY.

17

18 SUP. MOLINA: (SPEAKING IN SPANISH)

19

20  VOICE OF INTERPRETER: MRS. RAMIREZ, WE HAVE BEEN INVESTIGATING
21 SINCE LAST YEAR AND I PROMISE YOU THAT WE WILL FIND AN ANSWER

22 FOR YOU. YOU RECEIVED SEE A RESPONSE FROM US AND WE KNOW

23 YOU'RE NOT HAPPY WITH IT. BUT WE ARE WORKING AND WE WILL

24 CONTINUE TO HELP YOU. IT IS VERY HARD DUE TO THESE

25 COMPLICATIONS.
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SUP. MOLINA: WHAT I'VE SAID TO HER IS WE'VE BEEN WORKING WITH
HER SINCE SHE CAME LAST YEAR. WE OFFERED TO INVESTIGATE ALL OF
HER CLAIMS. WE INVESTIGATED ALL OF THE CLAIMS THROUGH THE
DEPARTMENT. UNFORTUNATELY, THEY AREN'T-- THEY DIDN'T RESULT IN
A RESPONSE THAT SHE THOUGHT SHE WOULD GET. THERE ARE TWO
FACTIONS WITHIN THE COALITION, THE DEPARTMENT OF MENTAL HEALTH
HAS STAYED OUT OF ANY REPRESENTING ONE SIDE OVER THE OTHER.
THERE WAS SOME INITIAL CONFLICT. WE PULLED THAT PERSON OUT.
AND NOW THEY'RE IN THE PROCESS OF TRYING TO FIND SOMEONE TO
MEDIATE THE DIFFERENCES. I DON'T KNOW IF MS. RAMIREZ WILL EVER
BE SATISFIED WITH THAT BUT WE CAN ONLY CONTINUE TO OFFER MORE

HELP. (SPEAKING IN SPANISH)

VOICE OF INTERPRETER: THANKS FOR YOUR TIME. THANK YOU.

SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. THERE'S NO OTHER PEOPLE

WHO WANT TO BE HEARD, WE'RE GOING TO GO INTO CLOSED SESSION.

CLERK SACHI HAMAI: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS,
NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL
CONVENE IN CLOSED SESSION TO DISCUSS ITEM CS-1, CONFERENCE
WITH LEGAL COUNSEL REGARDING SIGNIFICANT EXPOSURE TO
LITIGATION, ONE CASE, AS INDICATED ON THE POSTED AGENDA. THANK

YOU.
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REPORT OF ACTION TAKEN IN CLOSED SESSION ON APRIL 10, 2007

CS-1. CONFERENCE WITH LEGAL COUNSEL - ANTICIPATED LITIGATION
(Subdivision (b) of Government Code Section 54956.9)

Significant exposure to litigation (one case)

No reportable action was taken and the item was continued one

week to April 17, 2007.

CS-2. CONFERENCE WITH LEGAL COUNSEL - ANTICIPATED LITIGATION
(Subdivision (c¢) of Government Code Section 54956.9)

Initiation of litigation (one case(

In Open Session, the Board continued this item one week to

April 17, 2007.
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b UPERVRORS

1 I, JENNIFER A. HINES, Certified Shorthand Reporter
2 Number 6029/RPR/CRR qualified in and for the State of

3 California, do hereby certify:

4 That the transcripts of proceedings recorded by the
5 Los Angeles County Board of Supervisors April 10, 2007,

6 were thereafter transcribed into typewriting under my

7 direction and supervision;

8 That the transcript of recorded proceedings as

9 archived in the office of the reporter and which

10 have been provided to the Los Angeles County Board of

11  Supervisors as certified by me.

12 I further certify that I am neither counsel for, nor
13 related to any party to the said action; nor

14 in anywise interested in the outcome thereof.

15 IN WITNESS WHEREOF, I have hereunto set my hand this

16 12th day of April 2007 for the County records to be used only
17 for authentication purposes of duly certified transcripts

18 as on file of the office of the reporter.

19
20 JENNIFER A. HINES
21 CSR No. 6029/RPR/CRR
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